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• This guide explains how to install the software programs and 
briefly introduces their functions and operating procedures. 

• Please read the software license agreement in this guide before 
using the software. By using the software, you agree to be 
bound by the terms of the agreement. 
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IMPORTANT!
You must install 
the software 
before connecting 
the camera to the 
computer. 

Start by installing the 
software.

Attach the camera to 
the computer.

Wireless Connection Interface Cable Connection

Register the target 
device with the camera.

Connect Wirelessly.

Windows (p.13)
Macintosh (p.47)

Windows (p.78)



The precautions noted within this guide are intended to instruct you in the safe and correct use of 
the products and to prevent injuries or damage to yourself, other persons and property. Please 
read and ensure that you understand them before proceeding to other sections of the guide. 

Trademark Acknowledgments
• ArcSoft, the ArcSoft logo and ArcSoft PhotoStudio are trademarks or registered trademarks of 

ArcSoft, Inc.
• Adobe is a trademark of Adobe Systems Incorporated.
• CompactFlash is a trademark of SanDisk Corporation.
• Macintosh, Mac OS and QuickTime are trademarks of Apple Computer Inc., registered in the 

United States and other countries.

• Microsoft® and  Windows® are either registered trademarks or trademarks of Microsoft 
Corporation in the United States and/or other countries.

• Wi-Fi® and the Wi-Fi logo are registered trademarks of the Wi-Fi Alliance; and Wi-Fi CERTIFIED., 
WPA. and the Wi-Fi CERTIFIED logo are trademarks of the Wi-Fi Alliance.

• UPnPTM is a trademark of the UPnPTM Implementers Corporation.
• Other names and products not mentioned above may be registered trademarks or trademarks of 

their respective companies.

Copyright © 2005 Canon Inc. All rights reserved.

Canon Customer Support
For Canon Customer Support contacts, please see the Canon Limited Warranty supplied with 
your camera.

ArcSoft Customer Support
North America 
46601 Fremont Blvd., Fremont, CA 94538
Tel: 510-979-5599 (Mon. - Fri., 8:30 AM - 5:30 PM PST)
E-mail: support@arcsoft.com

Other Regions 
Please see the ArcSoft web site: http://www.arcsoft.com/maininternational.html.

SAFETY PRECAUTIONS

Warnings This symbol indicates topics that could lead to death or serious injury if 
ignored or handled incorrectly.

Warnings
• Do not play the supplied CD-ROM(s) in any CD player that does not support data CD-

ROMs. Playing the CD-ROM(s) in an audio CD player (music player) could damage the 
speakers. It is also possible to suffer from hearing loss from listening with headphones to 
the loud sounds of a CD-ROM played on a music CD player.

Disclaimer
• While every effort has been made to ensure that the information contained in this guide is 

accurate and complete, no liability can be accepted for any errors or omissions. Canon 
reserves the right to change the specifications of the hardware and software described 
herein at any time without prior notice.

• No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval 
system, or translated into any language in any form, by any means, without the prior 
written permission of Canon.

• Canon makes no warranties for damages resulting from corrupted or lost data due to a 
mistaken operation or malfunction of the camera, the software, the CompactFlash™ cards 
(CF cards), personal computers, peripheral devices, or use of non-Canon CF cards.
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Canon Software License Agreement
IMPORTANT - READ CAREFULLY BEFORE INSTALLING THE SOFTWARE!  This document is a legal 
agreement ("Agreement") between you and Canon Inc. ("Canon") and governing your use of this 
software, and online manual or other electronic documentation, and sound data and image data, 
if any (the "Software").  BY INSTALLING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE 
TERMS OF THIS AGREEMENT.  IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, 
PROMPTLY STOP THE INSTALLATION PROCESS.
1. GRANT OF LICENSE
(1) Canon grants you a non-exclusive license to use ("use" shall mean storing, loading, installing, 

executing, or displaying) the Software on your computers solely for use with Canon product.  You may 
allow other users of Canon's product to use the Software, provided that you shall impose on them on 
the assurance that such users shall abide by the terms of this Agreement and shall be subject to 
restrictions and obligations hereunder.

(2) With respect to the sound data and image data of the Software which is instructed to be used as 
installed in a Canon's digital still camera or digital video camcorder product ("Product") under the 
documentation for such Product, Canon grants you a non-exclusive license to install to and use them as 
installed in such Product.

(3) You may make one copy of the Software solely for back-up purpose, provided that you shall reproduce 
the copyright notice in the Software, on a medium of such back-up copy; provided, however, that you 
may not make any back-up copy when the Software is provided to you as stored in a medium and you 
use the Software as installed in permanent storage unit (e.g., hard disk drive) of a computer.  Any other 
copying of the Software is a violation of this Agreement.

2. RESTRICTIONS
You shall not use or copy the Software except as expressly granted or permitted herein, and shall not assign, 
sublicense, sell, rent, lease, loan, convey or transfer to any third party the Software, and you also shall not 
have any third party to do so.  In addition, you shall not alter, translate, modify, convert to any other 
programming languages, disassemble, decompile or otherwise reverse engineer the Software and you also 
shall not have any third party to do so.  You shall not modify, remove or delete any copyright notices 
appearing on the Software or on a medium, if any, on which the Software is delivered.  

3. OWNERSHIP
Canon and its licensor retain in all respects the title, ownership and intellectual property rights in and to 
the Software.  Except as expressly provided herein, no license or right, express or implied, is hereby 
conveyed or granted by Canon to you for any intellectual property of Canon.

4. EXPORT RESTRICTIONS
You agree to comply with all export laws and regulations of the country involved, and not to export or 
re-export, directly or indirectly, the Software in violation of any such laws and regulations, or without all 
necessary approvals.

5. SUPPORT AND UPDATE
Canon, Canon's subsidiaries and affiliates, their distributors and dealers are not responsible for 
maintaining the Software and helping you to use the Software, or providing you with any updates, bug-
fixes or support for the Software hereunder.

6. LIMITED WARRANTY AND DISCLAIMER
LIMITED WARRANTY.   THE SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OR 
CONDITION OF ANY KIND, EITHER EXPRESS, IMPLIED OR STATUTORY, INCLUDING, BUT NOT 
LIMITED TO THE IMPLIED WARRANTIES OR CONDITIONS OF DESIGN, QUALITY, 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.  ALSO, THERE IS NO 
WARRANTY OR CONDITION OF TITLE, QUIET ENJOYMENT, QUIET POSSESSION, 
CORRESPONDENCE TO DESCRIPTION OR OF NONINFRINGEMENT WITH RESPECT TO THE 
SOFTWARE.  THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE IS 
WITH YOU.  SHOULD THE SOFTWARE PROVE DEFECTIVE, YOU (AND NOT CANON, CANON'S 
SUBSIDIARIES AND AFFILIATES, THEIR DISTRIBUTORS AND DEALERS) ASSUME THE ENTIRE COST 
OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.  SOME STATES OR LEGAL 
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE 
EXCLUSION MAY NOT APPLY TO YOU.  THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS 
AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM STATE TO STATE OR 
JURISDICTION TO JURISDICTION.
Canon, Canon's subsidiaries and affiliates, their distributors and dealers do not warrant that the 
functions contained in the Software will meet your requirements or that the operation of the Software 
will be uninterrupted or error free.

READ CAREFULLY BEFORE USING
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However, if you are provided with the Software as stored in a medium, Canon warrants the medium to 
be free from defects in materials and workmanship under normal use for a period of ninety (90) days 
from the date of you obtained the same as evidenced by a receipt or otherwise.  
CUSTOMER REMEDIES.   Canon, Canon's subsidiaries and affiliates, their distributors and dealers' entire 
liability and your exclusive remedy shall be the replacement of the medium not meeting the LIMITED 
WARRANTY.  The LIMITED WARRANTY does not apply if failure of the medium has resulted from 
accident, abuse or misapplication of the Software and shall not extend to anyone other than you.
NO LIABILITY FOR DAMAGES.   IN NO EVENT SHALL CANON, CANON'S SUBSIDIARIES AND 
AFFILIATES, THEIR DISTRIBUTORS AND DEALERS BE LIABLE FOR ANY LOSS OR DAMAGES 
WHATSOEVER (WHETHER KNOWN, FORESEEABLE OR OTHERWISE), INCLUDING WITHOUT 
LIMITATION, ANY CONSEQUENTIAL, INCIDENTAL, DIRECT, INDIRECT, SPECIAL, PUNITIVE, OR 
OTHER DAMAGES WHATSOEVER (INCLUDING DAMAGES FOR LOSS OF PROFITS, BUSINESS 
INTERRUPTION, LOSS OF DATA, LOSS OF CONFIDENTIAL OR OTHER BUSINESS INFORMATION, OR 
OTHER COMPENSATORY, INCIDENTAL OR CONSEQUENTIAL DAMAGES) ARISING OUT OF OR IN 
ANY WAY RELATED TO THE SOFTWARE, USE THEREOF OR INABILITY TO USE THE SOFTWARE 
EVEN IF CANON, CANON'S SUBSIDIARIES OR AFFILIATES, THEIR DISTRIBUTORS OR DEALERS HAVE 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  SOME STATES OR LEGAL JURISDICTIONS 
DO NOT ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, OR PERSONAL INJURY OR DEATH RESULTING FROM NEGLIGENCE 
ON THE PART OF SELLER, SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.
DISCLAIMER OF INDEMNITY.   CANON, ITS LICENSOR, CANON'S SUBSIDIARIES AND AFFILIATES, THEIR 
DISTRIBUTORS AND DEALERS SHALL ASSUME NO OBLIGATION TO INDEMNIFY YOU AGAINST ANY 
CLAIM OR SUIT BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR USE THEREOF 
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY. 

7. TERM  
This Agreement is effective upon your acceptance hereof by installing the Software and remains in 
effect until terminated.  You may terminate this Agreement by destroying the Software including any 
and all copies thereof.  This Agreement shall also terminate if you fail to comply with any terms of this 
Agreement.  In the event that this Agreement terminates for your failure to comply with this 
Agreement, in addition to Canon enforcing its respective legal rights, you must promptly destroy the 
Software including any and all copies thereof.  Notwithstanding the foregoing, Sections 3, 5 through 7 
and 9 through 11 shall survive any termination hereof.  

8. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE  
The Software is a "commercial item," as that term is defined at 48 C.F.R. 2.101 (Oct 1995), consisting 
of "commercial computer software" and "commercial computer software documentation," as such 
terms are used in 48 C.F.R. 12.212 (Sept 1995).  Consistent with 48 C.F.R. 12.212 and 48 C.F.R. 
227.7202-1 through 227.7202-4 (June 1995), all U.S. Government End Users shall acquire the Software 
with only those rights set forth herein.  Manufacturer is Canon Inc./30-2, Shimomaruko 3-chome, Ohta-
ku, Tokyo 146-8501, Japan.

9. SEVERABILITY  
In the event that any provision of this Agreement is declared or found to be illegal by any court or tribunal 
of competent jurisdiction, such provision shall be null and void with respect to the jurisdiction of that 
court or tribunal and all the remaining provisions of this Agreement shall remain in full force and effect.

10.GOVERNING LAW  
The terms and conditions of this Agreement, the performance hereunder and the interpretation hereof 
shall in all respects be governed and construed in accordance with the laws of Japan.

11.ACKNOWLEDGMENT  
BY INSTALLING THE SOFTWARE, YOU AGREE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTOOD 
IT, AND AGREED THAT THIS AGREEMENT IS THE COMPLETE AND EXCLUSIVE STATEMENT OF 
AGREEMENT BETWEEN YOU AND CANON CONCERNING THE SUBJECT MATTER HEREOF AND 
SUPERSEDES ALL PROPOSALS OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER 
COMMUNICATIONS BETWEEN YOU AND CANON RELATING TO THE SUBJECT MATTER HEREOF.  NO 
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY AUTHORIZED 
REPRESENTATIVE OF CANON.
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Using the PDF Manuals
The following PDF-format manuals (hereafter PDF manuals) are provided to 
explain the features and procedures for using ZoomBrowser EX and 
ImageBrowser.
•ZoomBrowser EX Software User Guide (Windows)
• ImageBrowser Software User Guide (Macintosh)

Adobe Reader or Adobe Acrobat Reader must be installed to read 
the aforementioned PDF manuals. If one of these applications is 
not already installed on your computer, download it from the 
following website. 
http://www.adobe.com/products/acrobat/readstep2.html

Viewing PDF Manuals
Viewing Manuals Downloaded from a Website
These PDF-format manuals are available on the Canon website. Use your 
browser program to download these manuals from the following URL:
http://web.canon.jp/Imaging/information-e.html
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Read This First

This chapter explains what you can accomplish using the camera with the software contained 
on the Canon Digital Camera Solution Disk. 
It also lists the computer system configurations required to use the software.

About this Guide
•The explanations in this guide are based on Windows XP and Mac OS X v10.3. If you are 

using another version of these operating systems, the actual screen contents and 
procedures may vary slightly from those shown.

•The following terms are used in this guide.
Mac OS X is used for Mac OS X (v10.2-v10.4) 
Memory card is used for CF cards, SD cards, MultiMediaCards and PC cards.
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It’s so Simple! Make Prints Right at Home 
Like a Pro 

See your Camera User Guide for shooting instructions.

Just install the software once at the beginning.

Shoot the images

Install the software on the 
computer

Windows (p. 13)
Macintosh (p. 47)
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Download images to the computer

Print the images

Connect the camera to the computer

Windows (p. 19)
Macintosh (p. 49)

Windows (p. 24)
Macintosh (p. 53)

Precautions when 
Connecting (p. 12)

See the Camera User Guide for connection instructions.
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Wireless for Greater Convenience 
If you are using Windows XP SP2, you can use a wireless connection to send images to the 
computer and print them. The wireless networking function is not available for the Macintosh 
platform.

Send images to the computer

You will not need cables with a wireless connection. 

Send images to the computer and print them

Send images to the computer and print them out on a connected printer (printing 
via the computer). 

Wireless (p. 90)

Wireless (p. 90)
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Wireless (p. 98)

Operate the Camera Shutter from the Computer 

You can use ZoomBrowser EX to operate the camera shutter from the computer to 
shoot images (Remote Shooting). 

Wireless (p. 95)

The recorded images are downloaded directly 
to the computer.  

Automatically Save Images to the Computer while Shooting

Automatically Save Images to the Computer while Shooting (Auto Transfer)
The image is transferred to the computer after it records onto the memory card in the 
camera.
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Unbounded Possibilities with Entertaining 
Software 
Print a Variety of Layouts
Print with the diverse layouts available in ZoomBrowser EX/PhotoRecord (Windows) and 
ImageBrowser (Macintosh). The examples shown are from ZoomBrowser EX and PhotoRecord 
(Windows).

Stitch a Panorama Together
Create a panoramic image from a series of images with PhotoStitch. 

Confirm all your images in one glance 
with index (contact sheet) printing.

Make your 
pleasurable memories 
into photo albums/
collections with 
Layout Print. 

With One Photo per Page Print, 
printing images is also easy.
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Send an Image as an E-mail Attachment
Attach an image to an e-mail message by starting your mail software from within 
ZoomBrowser EX (Windows) or ImageBrowser (Macintosh).

Edit a Movie
You can edit movies, linking movies and stills that have been downloaded to the computer, 
adding text, such as titles, adding background music or applying various special effects. 

Extract Stills from Movies 
You can extract a still from the displayed movie and save it as a new image file. You can also 
specify a range of frames and extract multiple stills. 
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System Requirements
Please install the software on a computer meeting the following minimum requirements.

Windows
Windows XP (excluding the 64-bit version) with Service Pack 2 or later installed is required to 
use the wireless features. 

Macintosh
The wireless networking function is not available for the Macintosh platform.

OS Windows 98 Second Edition (SE)
Windows Me
Windows 2000 Service Pack 4
Windows XP (including Service Pack 1 and Service Pack 2)

Computer Model The above OS should be pre-installed on computers with built-in USB 
ports.

CPU Pentium 500 MHz or higher processor

RAM Windows 98 SE/Windows Me: 128 MB or more
Windows 2000/Windows XP: 256 MB or more

Interface USB/IEEE802.11b

Free Hard Disk 
Space

•Canon Utilities
- ZoomBrowser EX: 250 MB or more 

(Including the PhotoRecord printing program)
- PhotoStitch: 40 MB or more

•Canon Camera TWAIN Driver: 25 MB or more
•Canon Camera WIA Driver: 25 MB or more
•ArcSoft PhotoStudio: 50 MB or more

Display 1,024 x 768 pixels/High Color (16 bit) or better

OS Mac OS X (v10.2-v10.4)

Computer Model The above OS should be pre-installed on computers with built-in USB 
ports.

CPU PowerPC G3/G4/G5

RAM 256 MB or more

Interface USB

Free Hard Disk 
Space

•Canon Utilities
- ImageBrowser: 200 MB or more 
- PhotoStitch: 40 MB or more

•ArcSoft PhotoStudio: 50 MB or more

Display 1,024 x 768 pixels/32,000 Colors or better
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Programs and Compatible Operating Systems
The CD-ROM labeled “Canon Digital Camera Solution Disk” is provided with all models. It 
contains the following programs.

Windows Programs

*1 Can be started from within ZoomBrowser EX.
*2 Image editing program manufactured by ArcSoft, Inc. 
*3 Compatible with Windows 98 SE only.
*4 Driver not required because Windows XP supports PTP.
*5 Only supported by Windows XP (excluding the 64-bit version) with Service Pack 2 or later installed.

Macintosh Programs

*1 Can be started from within ImageBrowser.
*2 Image editing program manufactured by ArcSoft, Inc. 

• A CD-ROM drive is required to install the software.   
• Even when system requirements are met, not all computer functions can be guaranteed. 
• A sound card is required to play movie file audio tracks under Windows.
• With Windows, QuickTime 6.5 is required to save images merged with 

PhotoStitch as the QuickTime VR type. It is also required to play and edit 
movies on the Windows 98 SE, Windows Me and Windows 2000 platforms. 
QuickTime is included on the Canon Digital Camera Solution Disk.

• Macintosh software cannot be used on disks formatted in the UFS (Unix File System) format.

Compatible OS Windows
 98 

Windows
 Me 

Windows
 2000 

Windows
 XP Major Functions

Program

ZoomBrowser EX *3 Downloading, displaying, 
organizing and editing images 

TWAIN Driver *3 *4 Driver for Canon brand cameras (for 
Windows 98, Windows 2000)

WIA Driver *4 Driver (Windows Me)
PhotoRecord*1 *3 Layout and printing
PhotoStitch*1 *3 Merging images to make panoramas 

ArcSoft PhotoStudio*1 *2 Advanced image editing
Camera Wireless 
Setup

*5 Wireless configuration utility

Compatible OS
Mac OS X Major Functions

Program

ImageBrowser Downloading, displaying, organizing and editing images 

PhotoStitch*1 Merging images to make panoramas 
ArcSoft PhotoStudio*1 *2 Advanced image editing

See ArcSoft PhotoStudio (p. 107) for information about this program. 
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Before You Connect the Camera to the Computer

Precautions when Connecting
•The connection may not operate correctly if you attach the camera to the computer with an 

interface cable via a USB hub.
•The connection may not operate correctly if you are using other USB devices, excluding USB 

mice or keyboards, at the same time as the camera. If this occurs, disconnect the other 
devices from the computer and try reconnecting the camera.

•Do not connect two or more cameras at the same time to the same computer. The 
connections may not operate correctly.

•Never allow the computer to go into standby (sleep) mode while a camera is connected via 
the USB interface. If it does happen, never disconnect the interface cable. Try to awaken the 
computer with the camera in the connected state. Some computers will not awaken properly 
if you disconnect the camera while they are in standby (sleep) mode. Please refer to your 
computer manual for instructions regarding the standby (sleep) mode.

Security Precautions for Wireless LAN Products
Since wireless LANs use radio signals to exchange information between devices instead of 
cables, they have the merits of making a LAN connection possible within the range of the radio 
signal. Conversely, the following problems may occur if the network security settings are not 
correctly configured because the radio signals can travel beyond barriers (for example, walls) to 
their full range. 

•Data Content Can Be Spied Upon
Third parties with malicious intent may deliberately eavesdrop on radio signals and spy on 
image and other data in transmission. 

•Unauthorized Access
Third parties with malicious intent may access the network without consent and obtain image 
data (information leakage). They may commit the following offences: 
• Impersonate a person and transmit the data to others, distributing fraudulent information 

(impersonation)
•Alter and transmit intercepted transmissions (falsification)
•Corrupt image data (data corruption) 
Wireless LAN products generally have security features to deal with these issues, allowing you 
to configure the security settings and use the product with minimal risk. 

If you choose to use the product without configuring the security features, we recommend that 
you gain a full understanding of the potential problems and use the product on the basis of 
your own judgement and responsibility.

Ensure that you have installed the software from the supplied Canon Digital 
Camera Solution Disk before you connect the camera to the computer. 

•You are recommended to power the camera from a household power source 
(AC adapter) when connecting to a computer (if available for your camera 
model). Ensure that you use fully charged batteries if you will not be using a 
household power source. 

•See the Camera User Guide for procedures connecting the camera to the 
computer.
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Using the Software on the Windows 
Platform – Preparations

This chapter explains the basic procedures for installing the software and connecting the 
camera to a computer. Read this material before you connect the camera to the computer.

Installing the Software and USB Driver
Start by installing the software from the Canon Digital Camera Solution Disk.

Items to Prepare
•Your camera and computer
•Canon Digital Camera Solution Disk
• Interface cable supplied with the camera

Installation Procedures
1 Confirm that the camera is NOT connected to 

the computer. 
If it is, disconnect the cable. The software cannot 
be properly installed if the camera is connected to 
the computer at the start.

2 Close any programs that are running. 

• You must install the software before you connect the camera to the 
computer. 

• Windows XP or Windows 2000 users must log on to the computer as the 
Administrator before installing the software.

• Windows XP (excluding the 64-bit version) with Service Pack 2 or later 
installed is required to use the wireless networking function.

See ArcSoft PhotoStudio (p. 107) for details on how to install ArcSoft 
PhotoStudio.
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3 Place the Canon Digital Camera Solution Disk in the 

computer’s CD-ROM drive.
If the installer panel does not appear automatically, use the 
following procedures. 

4 Click the Digital Camera Software 
[Install] button.

How to Display the Installer Panel
Use the following procedures to display the installer panel if it does not appear 
automatically.

Windows XP
1. Select [My Computer] from the [Start] menu.
2. Right-click the CD-ROM icon and select [Open].

3. Double-click the [SETUP.EXE]  icon.

Windows 2000, Windows Me, Windows 98 SE
1. Double-click the [My Computer] icon on the desktop.
2. Right-click the CD-ROM icon and select [Open].

3. Double-click the [SETUP.EXE]  icon. 
Some computers may not display the [.EXE] file name extension as shown above.

Follow any instructions to restart your computer, if they appear. If the 
following window appears, continue with the installation.

Installer Panel
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5 Click [Next].

6 Select [Easy Installation] as the setup 
type and click [Next].

Select [Custom Installation] to select 
programs individually for installation. 

7 Click [Yes] if you agree to all of the terms of the software license agreement. 

When [Custom Installation] is Selected
•The USB driver (the software for connecting) is required when the 

camera is connected to the computer with an interface cable. Ensure 
that you select a USB driver from below (the appropriate one for your 
operating system). 
•Windows 2000/Windows 98 SE: Canon Camera TWAIN Driver 
•Windows Me: Canon Camera WIA Driver
With Windows XP, the USB driver supplied with the Windows operating 
system is used so there is no need to install a USB driver.

•Wireless connection software is required for a wireless connection 
between the camera and computer. Ensure that you select the following 
software. Wireless connections are only available for Windows XP 
(excluding the 64-bit version) with Service Pack 2 or higher installed. 
•Camera Wireless Setup (Utility for Wireless Connections)
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8 Review the installation settings and 

click [Next].
Follow the onscreen instructions to 
proceed.

The items displayed here differ according to 
the software installed.

9 When the installation is over, select 
[Yes, I want to restart my computer 
now.] and click [Finish].
If the camera is connected via a wireless 
network, please check your firewall settings 
before restarting the computer. See 
Firewalls (p. 105).

At this stage, do NOT remove the Solution 
Disk from the CD-ROM drive yet.

10 Remove the disk from the CD-ROM drive when your 
normal desktop screen appears after restarting.
If a security software warning message appears after you 
restart the computer, read Firewalls (p. 105) and change 
the settings.

This concludes the software installation. 
Continue by connecting the camera to the computer so 
that the USB driver can be utilized. 

Users of Windows XP and Windows 2000 must log in as an Administrator 
(computer system administrator) after restarting to carry out the 
subsequent procedures. 

If you installed a USB driver, so far the required files have only been 
copied to your computer. You must now connect the camera to the 
computer with the interface cable to complete the installation and 
prepare the driver for use. 
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11 Attach the camera to the computer with the 
interface cable and set the camera to the 
correct mode for connecting.

If the Digital Signature Not Found window 
appears, click [Yes].

The USB driver will automatically finish installing onto the computer when you attach the 
camera and open a connection. 
Dialogs similar to the following will appear during this process (first time the camera is 
connected to a computer only).

Windows XP 
The dialog on the right will appear after a 
few moments.

See Uninstalling the Software (p. 109) to delete the installed programs.

See the Camera User Guide for instructions to attach the camera to the 
computer and set it to the correct mode for connecting.
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Windows 2000/Windows Me/Windows 98 SE 
Restart the computer according to the instructions if you are prompted to do so by a 
message.

A dialog allowing you to set the default settings will display after installation. See Using 
the Software on the Windows Platform – The Basics (p. 19) for the subsequent 
procedures.

This concludes the software and USB driver installation and the procedures for connecting the 
camera to the computer.
You may now download camera images to the computer (p. 19). 

• See USB driver installation not proceeding well in the Troubleshooting
section (p. 114) if you are having problems installing the USB driver.

• See Uninstalling the USB Driver (p. 110) to delete the USB driver 
installed with these procedures.

• See If You Were Using ZoomBrowser EX Version 2 or 3 (p. 121) if you 
were previously using either version. 
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Using the Software on the Windows 
Platform – The Basics

This chapter explains the procedures for using ZoomBrowser EX to download the camera's 
images to the computer and print them.
Read this chapter after completing the preparations in the Using the Software on the Windows 
Platform – Preparations section. 

Downloading Images to the Computer
Begin by downloading the images to your computer. The downloading procedure is slightly 
different according to whether you are using a camera to computer connection (see below) or 
a memory card reader (p. 22). 

Camera to Computer Connection
1 Set the camera to the playback mode while connected to the computer.

For a wireless connection, see Connecting (p. 85).
For a wired connection, use the supplied interface cable to attach the computer's USB 
port to the camera's DIGITAL terminal. Prepare the camera for communication with the 
computer. 

The Camera Control Window will appear.
The window may differ slightly when 
connected wirelessly.

Camera Control Window

See the Camera User Guide for instructions on wired connections 
between the camera and computer and for communication modes.
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2 Download the images.
Download the images using the camera or 
the computer. By default, the downloaded 
images are saved into the [My Pictures] 
folder.

Placing a check mark here causes this 
window to automatically open when the 
camera and computer are connected.

You can adjust the settings, such as the type 
of image downloaded and the destination 
folder, by clicking [Preferences].

First Time Camera is Connected to a Computer
Please configure the following settings the first time you attach the camera to the 
computer with an interface cable. These procedures are not required from the second 
connection onward.

Select [Canon CameraWindow] when a 
dialog (Events dialog) similar to that on 
the right displays and click [OK].

Your camera model name or [Canon 
Camera] will appear here.

Different programs may display 
according to your computer setup.

If this Events dialog does not appear, click the [Start] menu and select 
[All Programs] or [Programs], followed by [Canon Utilities], 
[CameraWindow] and [CameraWindow].
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Using the Camera to Download Images (Direct Transfer Function)

Set the Direct Transfer settings on the 
camera and press the  (Print/Share)
button or the [FUNC./SET] button.

Direct Transfer menu

Using the Computer to Download Images
Click [Starts to download images].

The downloaded images will be saved into folders according to their shooting date.

Press the FFUNC./SET button to display the Direct Transfer settings menu. 
See Downloading/Printing Images Using Camera Commands (Direct 
Transfer) (p. 90) for the direct transfer settings and procedures.

• By default, all the images that have yet to be downloaded will download.
•To download images that have had their transfer settings set with the 

camera, click [Preferences] and select [Images whose transfer settings 
were specified with the camera] as the image type to be downloaded.

• Click [Lets you select and download images] to show the camera images 
in a list, check the images before downloading and download only 
selected images. 
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By default, when downloading is complete, 
the thumbnails (tiny versions) of the 
downloaded images display in 
ZoomBrowser EX’s Main Window. 

Thumbnail

The downloaded symbol displays on 
downloaded folders (the symbol will 
disappear when you exit ZoomBrowser EX).  

Next, print out the images (p. 24). 

Memory Card Reader Connection
1 Insert the memory card into the reader.

Use a separately sold card adapter if required.
See the manual for the memory card reader for its connection and handling instructions.

2 Select [View/Download Images using 
Canon CameraWindow] when the 
dialog to the right appears and click 
[OK]. 
The Camera Control Window will display.

If the dialog above fails to appear, click the [Start] menu and select [All 
Programs] or [Programs], followed by [Canon Utilities], [CameraWindow] 
and [CameraWindow], and proceed to Step 3.

(1) Place the memory card in an adapter if required. 

The card adapter and memory card shape may vary according 
to the type of memory card your camera utilizes.

(2) Insert the loaded adapter into the slot.
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3 Click [Starts to download images].

You can adjust the settings, such as the type 
of image downloaded and the destination 
folder, by clicking [Preferences].

The downloaded images are saved into folders according to the shooting date.

By default, when the download is complete, the thumbnails (tiny versions) of the 
downloaded images display in ZoomBrowser EX’s main window. 

Next, print out the images (p. 24). 

• By default, all the images that have yet to be downloaded will 
download to the [My Pictures] folder.

• To download images that have had their transfer settings set with the 
camera, click [Preferences] and select [Images whose transfer settings 
were specified with the camera] as the image type to be downloaded.

• Click [Lets you select and download images] to show the memory card 
images in a list, check the images before downloading and download 
only selected images.

• See Memory Card Folder Structure (p. 112) for information about 
memory card folder structures and file names.
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Printing Images
There are three ways in which images may be printed: One Photo per Page Print, Index Print 
and Layout Print. This section explains the One Photo per Page Print and Layout Print sections. 

One Photo per Page Print
This option prints one image per page in a standard "photo" format. If you select multiple 
images, it will print them on the corresponding number of pages. 

1 Click [Print] in ZoomBrowser EX's Main Window, followed by [One Photo Per Page 
Print].

•Movies cannot be printed, but you can print stills after they have been 
extracted from movies and saved to files. 

•To use the Index Print option, click [Print] in the Main Window, followed by 
[Index Print].

• If you have installed the Easy-
PhotoPrint program that 
accompanied a Canon-brand 
printer, you will proceed to the 
Easy-PhotoPrint printing window 
shown at the right when you 
select [One Photo Per Page Print] 
according to the default settings. 
If a window similar to it opens, 
read the Help menu for Easy-
PhotoPrint for instructions to proceed.

• To proceed to the ZoomBrowser EX printing window as shown in Step 2 
when you select [One Photo Per Page Print], click the [Tools] menu and 
select [Preferences], followed by the [Print] tab. Select [Use 
ZoomBrowser EX Print Functions]. 
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2 After confirming that [1. Select Images] is selected, select images.

You can select multiple images by holding the [Ctrl] down while clicking on successive 
images.

3 Click [2. Printer and Layout Settings] and adjust the categories as you feel 
necessary. 

4 Click [3. Print].
Printing will start.

The background of 
selected images 
changes to blue.

Selects the printer 
and the paper size 
etc.

Sets the number 
of print copies

This button switches between images if 
multiple images were selected. 

Sets printing to 
"borderless," etc.

Place a check mark 
here to print 
shooting date/time 
information with 
images.
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Layout Print
This option uses the PhotoRecord printing utility to arrange multiple images on a single page 
and print them like an album. 
This section explains the basic flow of steps to use PhotoRecord. Please see the PhotoRecord 
Help menu for detailed instructions. 

1 Click [Print] in ZoomBrowser EX’s Main Window, followed by [Layout Print].

2 Confirm that [1. Select Images] is selected and proceed to select images.
You can select multiple images by holding the [Ctrl] key down while clicking on successive 
images. 

The background of the 
selected image(s) will 
turn blue. 
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3 Click [2. Select Captions for Printing] 

and place a check mark beside the type 
of information that will be printed with 
the images.

If you select [Date and Time], for example, 
you can print the images with their shooting 
dates and times included.

4 Click [3. Open Layout Print].

PhotoRecord will start, displaying the 
selected image and the information 
selected in Step 3 in the Album window.
In addition, the steps that will take you 
through the printing process will display on 
the left side. Follow the steps in order to 
proceed. 

You can add a comment to an image in the Properties Window (p. 35).

Album Window
The selected images display 
here. 

The printing procedures display here.
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5 Click [2 Select Printer & Album Type]. 

Once you have chosen a printer, select 
[Free Form] in the Album type category. 

6 Click [3 Select Paper] and select the 
paper size and orientation.

7 Click [Decorate Album] and change the 
design of the image background and 
border as desired. 

Click the [Themes], [Backgrounds], [Photo 
Frames], [Text Frames] or [Clipart] button to 
switch between selections.

Perform the procedures according to the 
instructions beside the  symbol. 

• The [Themes] category provides consistent designs for use throughout 
an entire album.

•You can also click [Add Titles & Captions] to add text as a title or caption. 
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8 Click [4 Print], confirm the number of 

copies and other printing settings, and 
click [Print]. 

This will start printing. 
To close PhotoRecord after printing is complete, click . Click [Yes] to save the album or [No] 
to close it without saving. The ZoomBrowser EX window will reappear when the save 
procedure is complete.

This chapter explained the ZoomBrowser EX basics. Once you have mastered them, try the 
advanced techniques.
Using the Software on the Windows Platform – Advanced Techniques (p. 30). 

There are numerous varieties of albums. Select one to suit your purposes. 
Please note that the available album types may vary slightly according to 
the printer in use.

Album Type Description

One Photo Per Page
Prints one image on each sheet of paper.

One Photo Per Sheet

Free Form Allows images to be freely positioned on the page 
and printed. 

Index Prints thumbnails of the images and their shooting 
information Exif data*).

Fixed Size Photo Allows image heights and widths to be specified and 
prints.

Mosaic Lines up the specified number of images and prints.

Perforated Paper Prints on perforated paper.

8-Sticker Label Prints on 8-label sheets.

* The shooting information displayed in ZoomBrowser EX and the Exif data 
that can be printed using PhotoRecord differ slightly. 

•A PDF-format manual for ZoomBrowser EX is also available. It provides 
further information about the program's features and procedures. See Using
the PDF Manuals (p. 2).
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Using the Software on the Windows 
Platform – Advanced Techniques

This chapter explains various ZoomBrowser EX features. 
Proceed to this chapter once you have mastered the basic ZoomBrowser EX procedures in the 
Using the Software on the Windows Platform – The Basics chapter.

The ZoomBrowser EX Windows
This section describes the principal ZoomBrowser EX windows: the Main Window, Viewer 
Window and Properties Window.

Main Window
This window is for displaying and organizing images downloaded to the computer.

To confirm whether your camera supports these functions, please refer to 
Information about Your Camera (p. 123). 

Folders Area (p. 31)

Task Area (p. 31)

Browser Area (p. 31)

Function Buttons (p. 33)

Switches between showing and hiding 
the Task Area and Folders Area. 

Display Mode 
(p. 32)

Display Control 
Panel (p. 33)
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Task Area 
•ZoomBrowser EX's tasks are arranged here like 

an index.
•Click a Task button to carry out the desired 

task.
These features are described in ZoomBrowser 
EX Features (p. 36)

Folders Area 
•Use this area to select folders. The images in the selected folder display in the Browser Area.

If you select a network drive in advance with Windows Explorer, you can display network 
folders, but you cannot add, change or delete those folders in the Browser Area.

• If you selected Favorite Folders, only the folders registered in advance as Favorite Folders will 
display. You are recommended to register a folder that you use frequently as one of the 
Favorite Folders. If you selected All Folders, all the folders will display. 

Browser Area
•The images in the folder selected in the Folders Area will display here.

The display style will vary according to your Display Mode selection. 

•You can sort the image order in the Browser Area by file name, shooting date or other 
characteristics by clicking the [Tools] menu and selecting [View] and [Sort by].

•The following icons will display around images according to their attributes.

Images shot with the camera's Stitch Assist mode 

RAW images

Movies

Images with sound memo attachments

Protected images

Images shot with the camera's AEB function

Images shot with the camera on end that are rotated in the display only

Methods for Registering a Favorite Folder
• If [Favorite Folders] is displayed: click [Add] and select a folder. 
• If [All Folders] is displayed: select a folder and click [Add to Favorites].
• To delete a folder in the Favorite Folders area, select a folder and click the [Delete] button.

Methods for Selecting Images in the Browser Area
• Selecting a single image: click on an image.
• Selecting multiple images: click on the first image and then hold the [Ctrl] key down 

while clicking on additional images.
• Selecting consecutive images: click on the first image and then hold the [Shift] key down 

while clicking on the last image.
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Display Mode
•Selects the display style for the Browser Area.

Zoom Mode
Displays all the images in a folder as thumbnail 
images. This mode is convenient for searching 
for images since many can be displayed at 
once. 

If additional folders are nested within a 
folder, their images are displayed as 
thumbnails as well. 

If you move the mouse cursor over a folder, 
 will display on the upper right. Clicking 

here displays that folder zoomed in. 

Scroll Mode
This mode is convenient for checking the 
images in multiple folders at once. If the 
displayed folder is at the highest level, then all 
thumbnails in the lower-level folders also 
display. You can change the folder level (folder 
depth) by clicking the [Tools] menu and 
selecting [Preferences].

The images within nested folders also 
display.

Preview Mode
This mode displays the image at a larger size as 
well as the image information. 

Positioning the mouse pointer over a thumbnail causes the image to appear 
at a higher magnification in a Mouse Over Window. You can turn off this 
function by clicking the  [Show Information], and removing the check 
mark from the [Show Mouse Over Windows] option.
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Display Control Panel 
•This panel adjusts the display settings for the Browser Area.

Function Buttons
•These buttons are available for executing various functions.

Selection Menu
Use this to select or deselect all 
the images in the Browser Area. 

Show/Hide Image Information Menu
Use this to display or hide image 
information beneath the thumbnails, 
such as the file name, shooting date 
or Star Rating. 

Display Size
Changes the size of the 
thumbnail in the Browser Area.

Filter Images 
This feature filters your images by 
their Star Ratings, displaying only 
those images in the Browser Area. 
One of three Star Ratings can be 
assigned to an image in the Viewer 
Window, the Properties Window, or 
in the information column in the 
Preview Mode.

Select Button
Use this to select images 
in Zoom mode.

Fit to Window
Changes the thumbnail size to 
fit them into the window.

View Image Button
Displays the selected image 
or movie in the Viewer 
Window.

Slide Show Button
Starts a slide show of the 
selected images.

Properties Button
Displays information about 
the selected image in the 
Properties Window.

Search Button
Searches for images 
using such criteria as the 
Star Rating, 
modification date, 
shooting date, 
comments or keywords.

Delete Button
Deletes selected 
images or folders.

Rotate Button
Rotates the selected 
image.
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Viewer Window
Double-click an image in the Browser Area to display it in the Viewer Window.

• If a RAW image is displayed, the [Display Original Image] button displays 
beneath it. Clicking this button displays the converted image in the Viewer 
Window.

• If you are using Windows XP and display a movie file, the  (Capture Still 
Frame) button will display beside the Star Ratings. Clicking this button 
extracts still images from movies.

Edit Menu
You can edit, eliminating red eyes, 
adjusting colors, cropping and 
inputting titles. You can also use it to 
start up other programs for editing. 

Image Selector 
Button
Switches between 
images.

Full Screen Button
Displays the image in the full screen mode. Click the 
image or press any key on the keyboard to restore the 
normal display mode.

Synchronize Button
Synchronizes the 
display settings when 
multiple images are 
displayed. 

Star Rating
Sets the Star Rating for an image.

Zoom
Changes the image 
zoom setting.

Split Screen 
Button
Displays 
multiple 
images at 
once. This is 
handy for 
comparing 
images.

Sets the image 
display size to the 
size in the Viewer 
Window. 

Display AF Frame
Displays the AF Frame 
(area used to focus).

Displays images in 
the Viewer 
Window at their 
actual size. 

Print Button 
Prints the displayed image.

Shooting 
Information 
Display Button
Displays image 
shooting 
information.
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Properties Window
The Properties Window displays when you select an image in the Browser Area and click the 
Properties button. The Properties Window does not display in the Preview Mode.

Shows or hides 
categories.

Star Rating
Sets the Star Rating 
for an image.

Shooting Information
Displays detailed 
information about the 
shooting settings when the 
image was captured, such 
as the shutter speed or 
exposure setting. The 
camera model will 
determine what 
information is displayed. 

Protect
Prevents an image from being 
overwritten or deleted.

Comment
You can type a comment here.

Keywords
Sets the keywords used in 
searches.

Brightness Histogram
A graph of the highlights and 
shadows distribution in an 
image.

Image Selector Buttons
Switches between images.

Plays a sound memo attached 
to an image.
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ZoomBrowser EX Features
This section briefly introduces the Task Area functions.

Acquire & Camera Settings
Opens the Camera Control Window, which lets 
you perform the following operations.

Acquire Images
Downloads images from the camera/memory card (p. 19, 22).
Additionally, you can download sound files recorded with the Sound Recorder function on 
the camera. Refer to the ZoomBrowser EX PDF manual or Help for download instructions.

Print Images 
Selects and prints the images in a camera or memory card. You can print numerous ways, 
using DPOF settings, the Index Print option, One Photo per Page Print option, or by selecting 
images before printing. 

Set to Camera 
Sets camera settings, such as the My Camera settings (p. 42). It also uploads images from the 
computer to the camera/memory card.

Remote Shooting
Allows you to operate the camera shutter from the computer (p. 95).

View & Classify
View as a Slide Show
Starts a slide show of the images selected in the 
Browser Area.

Rename Multiple Files
Changes the file names of the selected images in a single pass.

Classify into Folder
Classifies images and saves them into a specified folder. 

Search 
Performs image searches using criteria such as the Star Rating, modification date, shooting 
date, comments or keywords. Star Ratings, comments and keywords can be set in the image 
information column in the Preview Mode or in the Properties Window. 

To confirm whether your camera supports these functions, please refer to 
Information about Your Camera (p. 123). 
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Edit
Edit Image
Allows you to perform image editing, such as 
cropping, image correction and red-eye 
correction. You can also use it to start other image editing programs. 

Stitch Photos
Merges multiple images and creates a single large panoramic image (p. 41).

Edit Movie
Edits movies or still images strung together. You can add text as titles, or background music, 
and apply various effects (p. 40).

Process RAW Images
Converts RAW images into standard images. You can adjust the image brightness, contrast 
and color balance among other attributes during conversion.

Export
Export Still Images
Allows you to change the image size or type, 
and export it as a new image. 

Export Movies
Allows you to change the movie size or type, and export it as a new movie.

Extract frames from a movie
Extracts still images from movies over a specified interval and saves them as image files 
(Windows XP only). 

Export Shooting Properties 
Allows you to select the necessary data from the shooting information and export it as a text 
file. 

Export as a Screen Saver
Exports the image as a screen saver file.

Export as a Wallpaper
Exports the image as a wallpaper file.

Backup to CD
Copies images to a CD-R/RW disk for backup. 

The Backup to CD function can only be used on computers satisfying the 
following requirements. 
•Windows XP is preinstalled
•A CD-R/RW drive is included as standard equipment
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Print
One Photo per Page Print
Prints one image per page (p. 24).
You can print "photo" prints easily.

Index Print
Lines up small versions of the images in rows and prints.

Layout Print
Allows you to arrange multiple images on one page and print them like an album. You can 
also insert captions and titles (p. 26). 

Print Using Other Software
Select the software to use and then print.

Internet
Email Images
Converts the selected images to the 
appropriate size for transmission by e-mail. You 
can also use it to automatically start an e-mail program after conversion.

•To return to the previous screen after selecting a task, click [Return to Main 
Menu] at the bottom of the task screen. 

•Various Help functions are available in ZoomBrowser EX. Click the [Help] 
menu, [?] button or [Help] button to display topics about operational 
procedures or the functions available.
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Replaying Movies
1 Double-click an image with a movie icon in ZoomBrowser EX’s Browser Area.

The Viewer Window will open and play the movie. 

Windows 2000, Windows Me and Windows 98 SE
QuickTime is required to play and edit movies. To install QuickTime, please follow these 

procedures.

1. Place the Canon Digital Camera Solution Disk in the CD-ROM drive. 
If the installer panel fails to appear automatically, display it using the procedures in the 
How to Display the Installer Panel section (p. 14).

2 Click the QuickTime [Install] button.

Follow the onscreen instructions to proceed with the installation.

You can save the displayed 
scene as a still image by 
clicking here.

You can control the 
movie's playback and 
sound volume.
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Editing Movies
You can create and edit movies: link movies and stills that have been downloaded to your 
computer, add background music, superimpose titles and other text, and apply various effects 
to the movies. 

1 Click [Edit] in ZoomBrowser EX’s Main Window, followed by [Edit Movie].

2 Click [1. Add Images] and select the image (movie or still) you wish to edit. 
You can select multiple movies or stills.

3 Follow the steps at the left of the window to edit the movie and save it. 

•The QuickTime program is required to replay or edit movies on the Windows 
2000, Windows Me or Windows 98 SE platform. Install it during procedures 
in the "Replaying Movies" topic in the Windows 2000, Windows Me and 
Windows 98 SE section (p. 39).

•Movies are saved as Motion JPEG AVI movies.

Click this button to 
play the movie 
being edited.

Follow these steps 
to proceed.

Storyboard Area
Displays thumbnails of the selected 
images.
Links images in order from left to right.

Click this button for detailed 
operational instructions.

Transition Effects Box
Appears between adjacent images 
and displays the symbols of the 
transition effects linking images.

Instructions
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Merging Panoramic Images - PhotoStitch 
You can create a wide panoramic image by merging several images. It is easier to merge 
images if they are shot with the camera's Stitch Assist mode because PhotoStitch can 
automatically detect the image order and orientation.

Images Shot in Stitch Assist Mode 
A sequence of images shot in Stitch Assist mode is saved into a single folder when it is 
downloaded from the camera. In addition, the symbol below displays by the image in the 
Browser Area. 

Starting PhotoStitch 
1 Click [Edit] in the ZoomBrowser EX’s Main Window and click [Stitch Photos].

2 Click [1. Select Images] and select several images in the Browser Area.

3 Click [2. Open PhotoStitch].

Instructions

4 Merge the images following the instructions in the guidance panel at the top of 
the PhotoStitch window.

• See the Camera User Guide for information about shooting in Stitch 
Assist mode.

• Images shot in Stitch Assist mode with a wide converter, teleconverter 
or close-up lens cannot be merged accurately. 

Symbol displayed by images shot in Stitch 
Assist mode.
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Enjoy Customizing Your Camera with the My 
Camera Settings
The start-up image, start-up sound, shutter sound, operation sound, and self-timer sound are 
called the My Camera settings. You can add your favorite images and sounds from your 
computer to the My Camera settings. This topic explains how to upload the My Camera 
settings saved onto your computer to the camera and vice versa.

Displaying the My Camera Window
1 Set the camera to the playback mode while connected to the computer.

For a wireless connection, see Connecting (p. 85).
For a wired connection, use the supplied interface cable to attach the computer's USB 
port to the camera's DIGITAL terminal. Prepare the camera for communication with the 
computer. 

The Camera Control Window will display. 
The window may differ slightly when connected wirelessly.

2 Click the [Set to Camera] tab. 

3 Click [Set My Camera].
The My Camera window will display. 

• See the Camera User Guide for instructions on wired connections 
between the camera and computer and for communication modes.

• Perform the settings described in First Time Camera is Connected to a 
Computer (p. 20) the first time you connect the camera to the 
computer. 
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The My Camera Window Features
ZoomBrowser EX already contains several pre-recorded My Camera settings. You can check 
these items with the My Camera window.

Tabs 
Click here to switch between adjusting the settings individually or in themed sets.

Displays the list of 
settings files saved 
onto the computer.

Play Button
Plays the audio from 
the selected settings 
file.

Delete Button
Deletes a settings file from 
the computer. 

Delete Button
Deletes a settings file 
from the camera.

Displays the settings in 
the camera.

Play Button 
Plays the audio from the 
settings file in the 
camera.

Save to Camera Button
Saves a computer 
settings file onto the 
camera.

Save to PC Button
Saves a camera settings 
file onto the computer.
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Saving the My Camera Settings to the Camera

1 Select the [Setup as a theme] tab in the My Camera window. 
To set the start-up image or sound individually, click the [Set individually] tab and select it.

2 Select the settings file you wish to save to the camera from the My Computer list. 
3 Select the setting from the Camera list that you would like to change and click 

[Save to Camera].
This concludes the process of saving the My Camera settings to the camera.
The Camera list setting will change to the selected file. If a setting for this category has 
previously been saved to the camera, it will be overwritten. 

Repeat steps 1-3 as required.
To use this data on the camera, change the start-up image and sound settings on the 
camera itself. Please see the Camera User Guide for these instructions.

Saving the Camera’s My Camera Settings to the Computer
1 Select the [Setup as a theme] tab in the My Camera window. 

To set the start-up image or sound individually, click the [Set individually] tab and select it.

2 Select the settings files from the Camera list that you wish to save to the 
computer.

3 Click [Save to PC].
4 Add a name to the settings file you are saving and click [OK].

This concludes the process of saving the My Camera settings to the computer.
Repeat steps 1-4 as required.

•My Camera settings can be selected and saved in either of two ways to the 
camera: individually or in theme sets. 

•The “Animal” theme, for example, features an animal in the start-up image 
and animal calls in each of the sound files. The names of the prepared files 
for the various My Camera settings themes all begin with the same root 
name. The start-up image and sound files in the "Animal" theme, for 
example, all begin with "Animal~". 

Do not detach the interface cable, turn the camera power off or disconnect 
the camera from the computer while the My Camera settings are being saved 
to the camera or the settings from the camera are being saved to the 
computer. 
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Adding New Data to the My Camera Window
Create a new image or sound file and add it to the My Camera window.
•Adding Image and Sound Files After Creating Them

Adding Original Start-up Images and Sounds After Creating Them
You can effortlessly create start-up image and sound files using the My Camera Maker
program. 

1 Click the [Edit] menu in the ZoomBrowser EX Main Window and select [Manage 
My Camera]. 
The My Camera window will display.

2 Click the [Set individually] tab in the My Camera window, followed by the [Create 
My Camera Data] button.

My Camera Maker will start.

3 Follow the instructions at the top part 
of the My Camera Maker window and 
create image or sound files. 

Instructions

Add File Button
Adds images and sound files for use 
as settings files. Added files display 
in the list.

Connect to camera Button
Connects to the camera. 
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4 Once you have saved the file, click  and close the My Camera Maker window.

You have now succeeded in adding the file as a settings file to the computer.

5 To connect to the camera, click 
[Connect to Camera]. 
To connect over a wireless network, click 
[Close] to close the window before 
connecting the camera and computer. 

You can add the settings files you just added to the computer to the camera using the 
same procedures as in "Saving the My Camera Settings to the Camera" (p. 44).

• Use settings like those below when creating an image file for the start-
up image using an image editing program other than My Camera 
Maker.

Compression Method : JPEG (Baseline JPEG)
Data Sampling : 4:2:0 or 4:2:2 
Pixels (w x h) : 320 x 240 pixels

•Use settings like those below when creating a sound file using a sound 
recording program other than My Camera Maker.

Compression Method : WAV (Monaural)
Quantifying Bits : 8 bit
Sampling Frequency : 11.025 kHz or 8.000 kHz

Use the following lengths as guidelines for the length of sound file that 
can be saved to the camera.    

Type
Duration in Seconds

11.025 kHz 8.000 kHz

Start-Up Sound 1.0 sec. or less 1.3 sec. or less

Shutter Sound 0.3 sec. or less 0.4 sec. or less

Operation Sound 0.3 sec. or less 0.4 sec. or less

Self-Timer Sound 2.0 sec. or less 2.0 sec. or less
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Using the Software on the Macintosh 
Platform – Preparations

This chapter explains the basic procedures for installing the software. Read this material before 
you connect the camera to the computer for the first time.

Installing the Software
Start by installing the software from the Canon Digital Camera Solution Disk.

Items to Prepare
•Your camera and computer
•Canon Digital Camera Solution Disk
• Interface cable supplied with the camera

Installation Procedures
1 Close any programs that are running. 
2 Place the Canon Digital Camera Solution Disk in the 

computer’s CD-ROM drive.

3 Double-click the [Canon Digital Camera Installer] icon 

 in the CD-ROM window.

4 Click the Digital Camera Software 
[Install] button. 

See ArcSoft PhotoStudio (p. 107) for details on how to install ArcSoft 
PhotoStudio.

Installer Panel
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5 Select [Easy Installation] and click 

[Next].

Select [Custom Installation] to select 
programs individually for installation. 

6 Click [Agree] if you agree to all of the 
terms of the software license 
agreement.

7 Review the installation settings and 
click [Next].
Follow the onscreen instructions to 
proceed.

8 When the installation is over, click [OK].

9 Click [Exit] in the installer panel and 
remove the disk from the CD-ROM drive.
This concludes the software installation. 

Continue by downloading images to the computer (p. 49). 

See Uninstalling the Software (p. 109) to delete the software installed 
with these procedures.
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Using the Software on the Macintosh 
Platform – The Basics

This chapter explains the procedures for using ImageBrowser to download the camera's images 
to the computer and print them.
Read this chapter after completing the preparations in the Using the Software on the 
Macintosh Platform – Preparations section. 

Downloading Images to the Computer
Begin by downloading the images to your computer. The downloading procedure is slightly 
different according to whether you are using a camera to computer connection (see below) or 
a memory card reader (p. 51).

Camera to Computer Connection

1 Attach the supplied interface cable to the computer’s USB port and the camera’s 
DIGITAL terminal. Prepare the camera for communication with the computer. 

The Camera Control Window will appear.
If it does not open, click the [CameraWindow] icon in the Dock (the bar at the bottom of 
the desktop). To set whether this window automatically opens when you connect the 
camera to the computer, remove the check mark from the [Start when a camera is 
connected] in the [File] menu in the Camera Control window.

You may not be able to download the camera images if there are more than 
approximately 1000 images in the camera. Use a memory card reader to 
download in that case.

See the Camera User Guide for instructions to attach the camera to the 
computer and set it to the correct mode for connecting.
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2 Download images.

Download the images using the camera or 
the computer. By default, the downloaded 
images are saved into the [Pictures] folder.

Camera Control Window

You can adjust the settings, such as the type 
of image downloaded and the destination 
folder, by clicking [Preferences]. 

Using the Camera to Download Images (Direct Transfer Function)

Set the Direct Transfer settings on the 
camera and press the  (Print/Share)
button or the [FUNC./SET] button.

Direct Transfer menu

Using the Computer to Download Images
Click [Starts to download images].

Press the FFUNC./SET button to display the Direct Transfer settings menu. 
See Downloading/Printing Images Using Camera Commands (Direct 
Transfer) (p. 90) for the direct transfer settings and procedures.
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By default, when the download is complete, the thumbnails (tiny versions) of the 
downloaded images display in ImageBrowser’s Browser Window.

Continue by printing out an image (p. 53).

Memory Card Reader Connection

1 Insert the memory card into the reader.
Use a separately sold card adapter if required.
See the manual for the memory card reader for details on how to connect and use the 
reader.

The Camera Control Window will appear.

• By default, all the images that have yet to be downloaded will download.
• To download images that have had their transfer settings set with the 

camera, click [Preferences] and select [Images whose transfer settings 
were specified with the camera] as the image type to be downloaded. 

• Click [Lets you select and download images] to show the camera images 
in a list, check the images before downloading and download only 
selected images.

Thumbnail

The downloaded symbol 
displays on downloaded 
folders (the symbol will 
disappear when you exit 
ImageBrowser). 

(1) Place the memory card in an adapter if required.

The card adapter and memory card shape may vary 
according to the type of memory card your camera 
utilizes.

(2) Insert the loaded adapter into the slot.
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If it does not open, click the [CameraWindow] icon in the Dock (the bar at the bottom of 
the desktop). To set whether this window automatically opens when you connect the 
camera to the computer, remove the check mark from the [Start when a camera is 
connected] in the [File] menu in the Camera Control window.

2 Click [Starts to download images].

You can set the type of image to download 
and the destination folder by clicking 
[Preferences]. 

By default, when the download is complete, the thumbnails (tiny versions) of the 
downloaded images will display in ImageBrowser's Browser Window when downloading 
is complete. 

Continue by printing out an image (p. 53).

• By the default settings, all images are downloaded to the [Pictures] 
folder. 

• To download images that have had their transfer settings set with the 
camera, click [Preferences] and select [Images whose transfer settings 
were specified with the camera] as the type of image for downloading. 

•Click [Lets you select and download images] to show the memory card 
images in a list, check the images before downloading and download 
only selected images.

• See Memory Card Folder Structure (p. 112) for information about 
memory card folder structures and file names.
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Printing Images
There are three ways in which images may be printed: One Photo per page Print, Index Print 
and Layout Print. This section explains the Print 1 Image per Page and Arrange and Print 
sections.

One Photo per page Print
This option prints one image per page in a standard "photo" format. If you select multiple 
images, it will print them on the corresponding number of pages.

1 Select the images to print.
Clicking on an image selects it and displays a blue frame around it. To select multiple 
images, hold down the [shift] or [ ] (command) key while clicking on images.

2 Click [Print] and select [One Photo per 
page Print].

Movies cannot be printed, but you can print stills after they have been 
extracted from movies and saved to files. 

A blue frame 
displays around 
selected images.
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3 Set the categories as you feel necessary.

4 Click [Print].
The Print window will now open.

5 After setting the number of copies, and other settings, click [Print].

6 After the printing finishes, click  to close the window.

Layout Print
Allows you to arrange multiple images on a single page and print. 

1 Select images for printing in the Browser Window.
Clicking on images selects them and changes the background to blue.
To select multiple images, hold the [shift] or [ ] key down while clicking on images.

2 Click [Print] and select [Layout Print].

Selects a printer.

Selects options such as the paper size 
and orientation when you click 
[Page Setup].

Place a check mark here to print the 
shooting dates/times with the 
images.

Sets the number of copies printed.

Click this button to switch between 
images if you selected multiple 
images.
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3 In the Print Style category, select [Custom layout printing] and set the categories 

as you feel necessary.

4 Change the layout or add text as you feel necessary in the Layout Print window.
See "Layout Print Window Features" (p. 56) for an explanation of procedures for 
changing the layout or adding text. 

5 Click [Print].
This will open the Print window.

6 After setting the number of copies, and other settings, click [Print].

7 After the printing finishes, click  to close the window.
To save the layout, click [Save]. To proceed without saving, click [Don't Save]. When the 
save operation is complete, the original ImageBrowser window will be restored. 

You can print a contact sheet of the thumbnails or print the image 
shooting information if you click [Print] in the Browser Window and 
select [Index Print]. 

Selects a printer.

Selects options such as the 
paper size and orientation 
when you click [Page Setup].
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Layout Print Window Features
When the [Custom layout printing] option is selected in the Layout Options window, you can 
freely change the size and position of the images for printing.

This chapter explained the ImageBrowser basics. 

Once you have mastered them, try the advanced techniques.
Using the Software on the Macintosh Platform – Advanced Techniques (p. 57). 

To print the shooting date, shooting time or the file name as the caption, click 
the [ImageBrowser] menu and select [Preferences]. Select [Print] from the list box 
at the upper left of the Preferences window and place check marks besides the 
desired items in the [Items to Print in Caption] category.

A PDF-format manual for ImageBrowser is also available. It provides 
further information about the program's features and procedures. See 
Using the PDF Manuals (p. 2).

Change the Image 
Size
Drag the border 
to resize the 
image. 

Change the default 
number of images 
printed per page.

Rotate the 
selected image. 

Vertically and horizontally lines 
up images in the window.

Edit the Page Title
Open the [Edit] menu and select [Edit Header].

Change the Layout
Drag the images to 
change the layout.

Add Text
Open the [Edit] menu 
and select [Add Text].

Add Captions to 
Images
Click the image and 
then the [Edit] menu 
and select [Edit 
Caption].

Displays the Print dialog.

Deletes images from the 
Layout Print window.

Saves the layout.

A part of the image 
is trimmed.
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Using the Software on the Macintosh 
Platform – Advanced Techniques

This chapter explains various ImageBrowser features. 
Proceed to this chapter once you have mastered the basic ImageBrowser procedures in the 
Using the Software on the Macintosh Platform – The Basics chapter.

The ImageBrowser Windows
This section describes the principal ImageBrowser windows: the Browser Window, Viewer 
Window and File Information Window.

Browser Window
This window is for displaying and organizing images downloaded to the computer.

To confirm whether your camera supports these functions, please refer to 
Information about Your Camera (p. 123).

Explorer Panel (p. 58)

Browser Area (p. 58) Display Mode (p. 59)

Display Control Panel (p. 60) Control Panel (p. 60)
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Explorer Panel 
•Use this area to select folders. The images in the selected folder display in the Browser Area.
• If you selected Favorite Folders, only the folders registered in advance as Favorite Folders will 

display. You are recommended to register a folder that you use frequently as one of the 
Favorite Folders. If you selected All Folders, all the folders will display. 

Browser Area
•The images in the folder selected in the Explorer Panel will display here.

The display style will vary according to your Display Mode selection. 

•The following types of icon will display around images according to their attributes.

Images shot with the camera's Stitch Assist mode 

RAW images

Movies

Images with sound memo attachments

Protected images

Images shot with the camera's AEB function

Images shot with the camera on end that are rotated in the display only

Methods for Registering a Favorite Folder
• If [Favorite Folders] is displayed: click [Add] and select a folder. 
• If [All Folders] is displayed: select a folder and click [Add to Favorites].

Methods for Selecting Images in the Browser Area
• Selecting a single image: click on an image.
• Selecting multiple images: click on the first image and then hold the [shift] or [ ] 

(command) key down while clicking on additional images.
• Selecting consecutive images: click on the first image and then hold the [shift] and 

[option] keys down while clicking on the last image.
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Display Mode
•Selects the display style for the Browser Area.

Preview
This mode displays the image at a larger size as 
well as the image information. 

List
Displays the images in the folder selected in the 
Explorer Panel section in rows and columns.

TimeTunnel 
Displays images in chronological order in a 
simulated time tunnel. You can move along a 
timeline from the past to the present using the 
slider that appears at the window's right.



Using the Software on the Macintosh Platform – Advanced Techniques60

Display Control Panel 
•This panel adjusts the display settings for the Browser Area.

Control Panel
•The control panel contains buttons for executing various functions. 

The functions displayed here are explained in the Control Panel Features section (p. 63).

Selection Menu
Use this to select or deselect all 
the images in the Browser Area. 

Hide Buttons
Left: Hides the Explorer Panel.
Middle: Hides the control panel. 
Right: Hides the image 

information in the Preview 
display mode.

Display Size
Changes the size of the thumbnail in 
the Browser Area.

Filter Images 
This feature filters your images by their Star 
Ratings, displaying only those images in the 
Browser Area.
One of three Star Ratings can be assigned to 
an image in the Viewer Window, the File 
Information Window, or in the information 
column in the Preview display mode.
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Viewer Window
Double-click an image in the Browser Area to display it in the Viewer Window.

• If a RAW image is displayed, the [Show Original Image] button displays 
beneath it. Clicking this button displays the converted image in the Viewer 
Window.

• If a movie file is displayed, the [Save as Still Image] button will display 
beside the Star Ratings.

Edit Menu
You can edit, performing such things as 
cropping, adjusting colors and brightness, 
eliminating red eyes and inserting texts.
You can also use it to start up other 
programs for editing. 

Image Selector Button
Switches between 
images.

Zoom
Changes the 
image zoom 
setting.

Full Screen Button
Displays the image in the full 
screen mode. Click the image or 
press any key on the keyboard to 
restore the normal display mode.

Synchronize Button
Synchronizes the display 
settings when multiple 
images are displayed. 

Star Ratings 
Menu
Sets the Star 
Rating for an 
image.

Number of Displays Menu
Displays multiple images at 
once. This is handy for 
comparing images.

Save Button
Saves the edited image.

Show Information Button
Displays the AF frame 
(focal point frame) and 
the shooting information.

Print Button 
Prints the displayed image.
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File Information Window
The File Information Window displays when you select an image in the Browser Area, click the 
[File] menu and select [Get Info]. The File Information Window does not display in the Preview 
display mode.

Plays a sound 
memo attached 
to an image.

Star Rating Menu
Sets the Star Rating for an image.

Shooting Information
Displays detailed information 
about the shooting settings when 
the image was captured, such as 
the shutter speed or exposure 
setting. The camera model will 
determine what information is 
displayed. 

Lock 
Prevents an image 
from being 
overwritten or 
deleted.

Comment
You can type a comment 
here.

Keyword
Sets the keywords used in 
searches.

Brightness Histogram
A graph of the highlights 
and shadows distribution 
in an image.

Image Selector Buttons
Switches between images.

Shows or hides 
categories.
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ImageBrowser Features
This section provides a brief introduction to ImageBrowser features.

Control Panel Features

Canon Camera
Opens the Camera Control Window, which lets you perform the following operations.

Acquire Images
Downloads images from the camera/memory card (p. 49, 51).
Additionally, you can download sound files recorded with the Sound Recorder function on 
the camera. Refer to the ImageBrowser PDF manual or Help for download instructions.

Print 
Selects and prints the images in a camera or memory card. You can print numerous ways, 
using DPOF settings, the Index Print option, Full Page Print option, or by selecting images 
before printing. 

Set to Camera 
Sets camera settings, such as the My Camera settings (p. 69). It also uploads images from the 
computer to the camera/memory card. 

Remote Shooting
Allows you to operate the camera shutter from the computer.

View Image
Displays the selected image or movie in the Viewer Window.

SlideShow
Starts a slide show of the selected images. Click the [View] menu and select [Slide Show 
Options] to set the slide show settings.

Internet 
Create Images for Email
Converts the selected images to the appropriate size for transmission by e-mail. You can also 
use it to automatically start an e-mail program after conversion. 

To confirm whether your camera supports these functions, please refer to 
Information about Your Camera (p. 123).
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Print
One Photo per page Print
Prints one image per page (p. 53).
You can print "photo" prints easily.

Index Print
Lines up small versions of the images in rows and prints.

Layout Print
Allows you to freely arrange multiple images on a single page and print. You can also insert 
captions and titles (p. 54). 

Send to Trash
Sends the selected images or folders to the Trash.

Functions Selected from Menus
Search Images: [File] menu, [Search]

Searches for images based on such criteria as Star Ratings, dates, keywords, keywords or 
captions. 

Export Images: [File] menu, [Export Images]
•Edit and Save: allows you to change the file type or size and export the file.
•Export Shooting Properties: allows you to export the shooting properties as a text file.
•Export as a Screensaver: Exports the image as a screen saver file.
•Export an Image as Wallpaper: Exports the image as a wallpaper file.

Organize Images: [File] menu, [Organize Image]
•Sort Images: sorts images according to criteria such as the shooting date or Star Rating and 

saves them into a specified folder.
•Rename: changes the files names of multiple images in a single pass.

Convert RAW Images: [File] menu, [RAW image processing]
Converts RAW images. You can adjust the image brightness, contrast and color balance 
among other attributes during conversion.

Merge Panoramas: [Edit] menu, [PhotoStitch]
Merges multiple images and creates a single large panoramic image (p. 68).

Edit Movies: [Edit] menu, [Movie Edit]
Edits movies or still images strung together. You can add titles or background music and 
apply various effects (p. 67).

Extracting Stills from Movies: [Edit] menu, [Extract frames from a movie]
Extracts still images from movies over a specified interval and saves them as image files. 
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Display Settings: [View] menu, [View Settings]

Hides or shows image information beneath the thumbnail, such as the file name or the 
shooting date and time.

Sort Images: [View] menu, [Sort]
Arranges image order in the Browser Area according to criteria such as the filename, file 
modification date, file size or shooting date.
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Replaying Movies
1 Double-click an image with a movie icon in ImageBrowser’s Browser Area.

The movie will appear in the Viewer 
Window. 

Movie icon

2 Click the [Play]  button.

You can save the displayed scene 
as a still image by clicking here.

You can control the 
movie's playback and 
sound volume.
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Editing Movies
You can create and edit movies: link movies and stills that have been downloaded to your 
computer, add background music, superimpose titles and other text, and apply various effects 
to the movies. 

1 Select the image(s) to edit in ImageBrowser’s Browser Area (movies or stills). 
You can select multiple movies or stills.

2 Click the [Edit] menu and select [Movie Edit]. 

3 Follow the steps displayed in the middle of the window to edit the movie and save 
it.

Click this button 
to play the movie 
being edited.

Follow these steps 
to proceed.

Storyboard Area
Displays thumbnails of the 
selected images.
Links images in order from 
left to right.

Click this button 
for detailed 
operational 
instructions.

Transition Effect Box
Appears between adjacent 
images and displays the 
symbols of the transition 
effects linking images.

Instructions
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Merging Panoramic Images - PhotoStitch 
You can create a wide panoramic image by merging several images. It is easier to merge 
images if they are shot with the camera's Stitch Assist mode because PhotoStitch can 
automatically detect the image order and orientation. 

Images Shot in Stitch Assist Mode 
A sequence of images shot in Stitch Assist mode is saved into a single folder when it is 
downloaded from the camera. In addition, the symbol below displays by the image in the 
Browser Area.

Symbol displayed by images shot in Stitch Assist 
mode. 

Starting PhotoStitch 

1 Select a series of images in the ImageBrowser’s Browser Area. 
2 Click the [Edit] menu and select 

[PhotoStitch].

Instructions

3 Merge the images following the 
instructions in the guidance panel at the top of the PhotoStitch window.

• See the Camera User Guide for information about shooting in 
Stitch Assist mode.

• Images shot in Stitch Assist mode with a wide converter, 
teleconverter or close-up lens cannot be merged accurately.
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Enjoy Customizing Your Camera with the My 
Camera Settings
The start-up image, start-up sound, shutter sound, operation sound, and self-timer sound are 
called the My Camera settings. You can add your favorite images and sounds from your 
computer to the My Camera settings. This topic explains how to upload the My Camera 
settings saved onto your computer to the camera and vice versa.

Displaying the My Camera Window
1 Attach the supplied interface cable to the computer's USB port and the camera's 

DIGITAL terminal and place the camera in the correct mode for connecting.

The Camera Control Window will display. 

2 Click the [Set to Camera] tab. 

3 Click [Set My Camera].
The My Camera window will display. 

• See the Camera User Guide for instructions to attach the camera to the 
computer and set it to the correct mode for connecting.

• If the Camera Control Window does not automatically appear, click the 
[CameraWindow] icon in the Dock (the bar at the bottom of the 
desktop). 
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The My Camera Window
ImageBrowser already contains several pre-recorded My Camera settings items. You can check 
these items with the My Camera window.

Type 
Select the settings type. 

Displays the list 
of settings files 
saved onto the 
computer.

Play Button
Plays the audio from the 
selected settings file.

Send to Trash Button
Deletes a settings file 
from the computer.

Save to Camera Button
Click here to save the 
settings onto the 
camera.

Delete Button
Deletes a settings 
file from the 
camera. 

Displays the 
settings in the 
camera.

Play Button 
Plays the audio from 
the settings file in the 
camera.

Save to Camera
Save to Computer 
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Saving the My Camera Settings to the Camera

1 Select the type of setting in the Type list box that you wish to save to the camera.
2 Select the setting from the Computer list that you would like to add.
3 Select the setting in the Camera list that you would like to change and click the 

 button.
The Camera list setting will change to the selected file. If a setting for this category has 
previously been saved to the camera, it will be overwritten.
Repeat steps 1-3 as required.

4 Click the [Save to Camera] button.
This concludes the process of saving the My Camera settings to the camera. 
To use this data on the camera, change the start-up image and sound settings on the 
camera itself. Please see the Camera User Guide for these instructions. 

Saving the Camera’s My Camera Settings to the Computer
1 Select the type of setting you wish to save to the computer from the Type list box.
2 Select the setting in the Camera list that you wish to save to the computer. 
3 Click the  button.
4 Input a file name to the selected setting and click the [OK] button.

This concludes the process of saving the My Camera settings to the computer. 
Repeat steps 1-4 as required.

•My Camera settings can be selected and saved in either of two ways to the 
camera: individually or in theme sets. 

•The “Animal” theme, for example, features an animal in the start-up image 
and animal calls in each of the sound files. The names of the prepared files 
for the various My Camera settings themes all begin with the same root 
name. The start-up image and sound files in the "Animal" theme, for 
example, all begin with “Animal~”. 

Do not detach the interface cable, turn the camera power off or disconnect 
the camera from the computer while the My Camera settings are being saved 
to the camera or the settings from the camera are being saved to the 
computer. 
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Adding New Data to the My Camera Window
Create a new image or sound file and add it to the My Camera window.
•Adding Image and Sound Files After Creating Them

Create an Original Start-up Image File and then Add It
Start by using an image editing program to create the image file that will become the start-up 
image and save it to the computer. Create a JPEG image at a size of (w) 320 x (h) 240 pixels.

1 Click the [File] menu in the ImageBrowser Main Window and select [Canon 
Camera] and [My camera].
The My Camera window will display.

2 Select the [Start-up Image] in Type.

3 Click [Add].

4 Select the file you created and click [Open].
This concludes the process for adding new data.

5 To connect to the camera, click [Connect to Camera]. 
You can add the settings files you just added to the computer to the camera using the 
same procedures as in "Saving the My Camera Settings to the Camera" (p. 71).

Add Button
Adds images and 
sound files for use as 
settings files. Added 
files display in the list.

Connect to Camera Button
Connects to the camera. 
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Add an Original Sound File
Change the file to a WAV sound file after you have copied the sound file to the computer. 
Then proceed with the steps as described in Create an Original Start-up Image File and then 
Add It.

•Use settings like those below when creating an image file for the start-
up image with an image editing program.

Compression Method : JPEG (Baseline JPEG)
Data Sampling : 4:2:0 or 4:2:2 
Pixels (w x h) : 320 x 240 pixels

•Use settings like those below when creating a sound file with a sound 
recording program.

Compression Method : WAV (Monaural)
Quantifying Bits : 8 bit
Sampling Frequency : 11.025 kHz or 8.000 kHz

Use the following lengths as guidelines for the length of sound file that 
can be saved to the camera. 

Type
Duration in Seconds

11.025 kHz 8.000 kHz

Start-Up Sound 1.0 sec. or less 1.3 sec. or less

Shutter Sound 0.3 sec. or less 0.4 sec. or less

Operation Sound 0.3 sec. or less 0.4 sec. or less

Self-Timer Sound 2.0 sec. or less 2.0 sec. or less
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Wireless Network Settings for the 
Computer and Camera 

This chapter explains how to configure the wireless networking function to connect the camera 
to the computer over a wireless connection.

Procedures
Follow the procedures below to configure the wireless settings.

Preparation

Check Your Computer's Operating Environment
Confirm that your computer's operating system is Windows XP (excluding the 64-bit 
version) with Service Pack 2 or later installed.

Check Your Wireless Connection Configuration
In order to ensure that the registration procedures for the connection proceed smoothly, 
confirm the network configuration for your computer and prepare it as necessary. 

Check If Required Software Is Installed
Confirm that the software required for a wireless connection has been installed.

Registering the Target Device

Register the Target Device with the Camera
Connect the camera to the computer with the interface cable and register the target 
device (your computer) with the camera. 

Using the Wireless Networking Function

Use the Wireless Networking Function
Connect the camera and computer over the wireless connection and download camera 
images to the computer or print them. See Actions Possible with the Camera 
Connected to a Computer (p. 89) for the features that can be used over a wireless 
connection. 

The procedures in the "Preparation" and "Registering the Target Device" sections 
are performed the first time you make a wireless connection. Thereafter, only the 
procedures in the "Using the Wireless Networking Function" section are required.
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Preparation-Before You Use the Wireless Connection
This section explains the preparations to make before you use the wireless connection.
Start by checking your computer's operating environment.

Checking Your Computer's Operating Environment

Operating System Environment
The wireless feature can only be used with the Windows XP (excluding the 64-bit version) 
operating system with Service Pack 2 or later installed. It cannot be used with other Windows 
or Macintosh operating systems. 

Environment Required for the Wireless Networking Function 
Either of the following two configurations is required to use the wireless feature. 
•The computer has a wireless setup (i.e. a wireless LAN card installed)
•A wireless LAN router is connected to the computer. 

The firewall settings in Windows XP or your security software may prevent the 
camera and computer from connecting. See Firewalls (p. 105). 
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Checking Your Wireless Connection Configuration
The method for connecting the camera to the computer will vary according to your computer's 
wireless connection configuration. See the following diagram and confirm that your 
configuration uses connection method  or . 

Wireless Network 
Already in Use

1:1 Direct 
Connection 

between Camera 
and Computer

Add the camera to the wireless 
network in use.

Create a new network for the camera 
and computer.

Check the settings for your wireless 
network and note them in the 
checklist (next page).

Connecting a camera and computer 
via an access point, such as a wireless 
LAN router, is called an 
"infrastructure connection".

Connecting a camera and computer 
directly in a 1:1 connection is called 
an "ad hoc connection".

• A router is a device for connecting several computers or other equipment in a 
network (LAN). A router with a built-in wireless networking function is called a 
wireless LAN router.

• See your computer's user guide if you are uncertain about its operating system.

A B

A
B

Existing Network

Wireless LAN Router
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Checking Your Wireless Network Configuration (Configuration  Only)
If you are already using a wireless network, check the following settings and note them in the 
checklist. 

Check If Required Software Is Installed
Before configuring the wireless settings, confirm whether or not the supplied software has 
been installed. 
If the software is not yet installed, use the supplied Canon Digital Camera Solution Disk and 
install it according to the procedures in Using the Software on the Windows Platform-The 
Basics (p. 19).

• If you are configuring a network managed by a system administrator, obtain 
the network settings information from the network administrator.

• An encryption key is an important asset. Manage it securely so that no one 
else can learn what it is.

• See the user guide for your wireless LAN router for details on checking the 
settings.

Checklist

•Network Name (SSID, ESSID) Please enter the name assigned to 
the wireless network you are using.

•Network Authentication/Data 
Encryption (Encryption Method, 
Encryption Mode)

Invalid
WEP (Open)
WEP (Shared Key)
WPA-PSK-TKIP
WPA-PSK-AES

"Network Authentication/Data 
Encryption" is the encryption method 
for data during a wireless 
transmission. 
Enter a check mark beside the 
method used by your wireless 
network. 

•Encryption Key (Network Key) The Encryption Key is the key used to 
encrypt data during a wireless 
transmission. Confirm the key used in 
your wireless network. (Be extremely 
careful in handling it since it is vital 
information.) 

•Key Index (Transmit Key)

1
2
3
4

The Key Index is a key that is set 
when the Network Authentication/
Data Encryption setting is WEP. Up to 
four keys can be set for one access 
point. Please place a check mark 
beside the key index used by your 
wireless network.

A
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Registering the Target Device with the Camera
Attach the camera to the computer using the interface cable and register the target device 
(computer to be connected wirelessly) with the camera. Configure the settings using the 
Camera Wireless Setup program (a wireless configuration utility). This step is only required the 
first time you register a target device.

1 If your wireless network is already in use, confirm that the computer and router are 
correctly connected and that the router's wireless settings are correctly configured. 

 If there is a 1:1 direct connection between the camera and computer, confirm 
that the computer's wireless networking function is working.

2 Attach the supplied interface cable to the 
computer's USB port and the camera's 
DIGITAL terminal.

3 Turn on the camera and set it to the playback 
mode.
The camera's  (Print/Share) button will light 
blue.

The Camera Control Window will appear on the 
computer screen. Leave this window as is without 
closing it. 

•The camera cannot connect wirelessly to computers that have not been 
registered as target devices.

•The camera can register up to 7 devices. 

Wireless Network Already in Use

1:1 Direct Connection between Camera and Computer

Both  and  share steps 1-8.
For Step 9 onward go to  Wireless Network Already in Use (p. 81) or  1:1 Direct 
Connection between Camera and Computer (p. 83).

A

B
A B

A B

A

B

Power Button

Playback 
Mode
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4 Press the camera's MMENU button.

5 Select the [  (Wireless)] menu in the 
camera's LCD monitor and choose [Reg. 
Target Device].

6 Press the FFUNC./SET button.

"Input data on PC" will appear on the camera's 
LCD monitor.

The Camera Wireless Setup utility, as shown to 
the right, will start up. Set the wireless settings in 
this window.

7 Click [Next].

MENU 
Button

FUNC./SET 
Button
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8 Select [Simple Mode] and click [Next].

We recommend you use the Simple Mode for 
most purposes. 

•We recommend you use the [Advanced Mode] if the following 
conditions apply to your computer's wireless configuration.
•You are configuring an ad hoc network.
•You are performing the settings within a network with a system 

administrator.
•The computer and wireless LAN router are connected by a cable. 
•A fixed IP address is assigned. (IP address: an identifying number 

assigned to a computer or other device on a network)
•Wireless LAN router is not equipped with a DHCP server function. 

(DHCP server function: short for dynamic host configuration protocol 
server function, which assigns dynamic IP addresses to devices in a 
network)

•You can change the registered information in the camera if you place a 
check mark beside [Change registered information in camera] and click 
[Next].

If you are already using a wireless network, please proceed to Step 9 in the  Wireless 
Network Already In Use section (p. 81).
If you are using a 1:1 direct connection between the camera and computer, skip to 
Step 9 in the  1:1 Direct Connection between Camera and Computer section (p. 83).

A

B
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9 Select [I am using an access point] and click 
[Next].
This window will not appear if the wireless 
configuration information is automatically 
detected. Proceed to the next step.

10 Enter the settings information from the 
checklist (p. 77) and click [Next].
You do not have to enter some of the 
configuration information if it was automatically 
detected. Make sure the information is the same 
as entered in the checklist, and  enter the 
information required for the remaining settings 
categories. 

11 Confirm the displayed information and click 
[Next].
The name you enter here will display in the 
camera's "Connected To" category.

Wireless Network Already in Use

Perform steps 1-8 (pp. 78-80) before proceeding below.

If you do not understand the terminology in the window, place the mouse cursor 
over it. A brief explanation will display at the bottom of the window.

If the "Insufficient space in camera" message appears, delete target devices that are 
not needed and proceed to the next step.

A
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12 After confirming the displayed settings, click 
[Print] to print out the configuration 
contents.
This information will be necessary if you cannot 
make a connection or later change the settings. 
Store this information in a secure place because it 
is important information about your computer. 

13 After the printing finishes, click [Next].

14 Click [Finish].

15 When [Registration completed] appears on 
the LCD monitor, press the FFUNC./SET button. 
This registers the network configuration on the 
camera.

16 Press the camera's MENU.
The camera will return to the playback mode.

17 Turn off the camera.
The Camera Control Window on the computer screen will close.

18 Detach the interface cable and connect wirelessly.
Please use the procedures in Connecting to test the correction operation of the wireless 
connection (p. 85).
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9 Select [I do not have an access point, but my 
computer is compatible with wireless 
networks] and click [Next].
This window will not appear if the wireless 
configuration information is automatically 
detected. Proceed to the next step.

10 Confirm the configuration settings and click 
[Next].
The configuration settings will automatically take 
effect and appear in the window. These settings 
generally do not require adjusting. 

11 Confirm the displayed information and click 
[Next].
The name you entered here will display in the 
camera's "Connect to" category.

1:1 Direct Connection between Camera and Computer

Perform steps 1-8 (pp. 78-80) before proceeding below.

If you do not understand the terminology in the window, place the mouse cursor 
over it. A brief explanation will display at the bottom of the window.

B
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12 After confirming the displayed settings, click 
[Print] to print out the configuration 
contents.
This information will be necessary if you cannot 
make a connection or later change the settings. 
Store this information in a secure place because it 
is important information about your computer. 

13 After the printing finishes, click [Next].

14 Click [Finish].

15 When [Registration completed] appears on 
the LCD monitor, press the FFUNC./SET button. 
This registers the network configuration on the 
camera.

16 Press the camera's MMENU button.
The camera will return to the playback mode.

17 Turn off the camera.
The Camera Control Window on the computer screen will close.

18 Detach the interface cable and connect wirelessly.
Please use the procedures in Connecting to test the correction operation of the wireless 
connection (p. 85).

If the "Insufficient space in camera" message appears, delete target devices that are 
not needed and proceed to the next step.

• If a message concerning settings 
appears, follow the instructions on 
the screen and change settings. For 
details on how to change settings, 
refer to the computer's user guide.

•  If you set up an IP address, be sure 
to use a different address than the 
one that was displayed during step 
12.
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Connecting
Connect to the computer using the camera controls. 
You will not require an interface cable because you are connecting wirelessly.
Connect after you have registered the target device (computer) according to the procedures in 
Registering the Target Device with the Camera (p. 78).

1 Turn on the camera and set it to the playback 
or shooting modes.

Playback Mode
After connecting, you can download camera 
images to the computer and print them on a 
printer. 

Shooting Modes
After connecting, you can transmit a recorded 
image immediately to the computer. 

See Actions Possible with the Camera Connected to a Computer (p. 89) for details.

2 Press the  button.
A menu for selecting the target device will appear 
in the LCD monitor.

The  button will light blue.

• The wireless networking function can be operated up to approximately 30 
meters away with a direct line of sight to the target device. However, this 
distance will depend upon the operating conditions. 

• You cannot have more than one camera connected at a time.

•The movie mode cannot be used over a wireless connection. 
•You can switch between the playback and shooting modes over the 

wireless connection.

Alternatively, you can display the menu for selecting the target device by 
pressing the MENU button, selecting the [  (Wireless)] menu followed 
by the [Connect/Disconnect] option, and pressing the FUNC./SET button.

Power Button

Playback 
Mode or 
Shooting 
Modes

 Button

FUNC./SET 
Button

MENU 
Button
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3 After you have selected a target device, select 

[Connect].
The name registered for the target device in Step 
11 (p. 81, 83) in Registering the Target Device 
with the Camera will appear in the [Target Device] 
category.

4 Press the  button (or FFUNC./SET button).
The wireless lamp and  button will blink 
while the two devices connect.

The LCD monitor will display an indicator that 
shows the connection status.

When the camera connects to the computer, the 
wireless lamp will stop blinking and light steadily. 
An antenna showing the signal strength will 
appear in the LCD monitor. (0-3 bars)

You cannot connect to multiple target devices at once. If you are already 
connected to one device and attempt to connect another, the current 
connection will close and the camera will begin to connect to the new target 
device. 

• Unless you change the target device, you can connect later simply by pressing 
the  button in Step 2 for one second.

• "If an error message displays on the camera's LCD monitor, see the 
Connection Difficulty topic in the Wireless Connection Troubleshooting
section (p. 100).  

 Button

FUNC./SET 
Button

In Playback Mode
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Disconnecting
Disconnect the camera from the computer using camera commands.

1 Set the camera to the playback or shooting modes.

2 Press the MMENU button.

3 In the [  (Wireless)] menu, select [Connect/
Disconnect] and press the FFUNC./SET button.

4 After you select the target device, select 
[Disconnect].

5 Press the FFUNC./SET button.
This will disconnect the camera and computer.

The wireless lamp will turn off when the camera is 
disconnected from the computer. 
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Deleting a Target Device
Delete a target device if its registration is no longer required or you wish to register a new 
device but have already reached the maximum number of registrations.

1 Set the camera to the playback or shooting modes.

2 Press the MMENU button.

3 In the [  (Wireless)] menu, select [Delete 
Registration] and press the FFUNC./SET button.

4 Select the target device you would like to 
delete.

5 Select [Delete] and press the FFUNC./SET
button.
The selected device will be deleted and the name 
of the next device will display.

6 Press the MENU button.
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Using the Wireless Networking Function

This section explains how to use the wireless networking function to download camera images 
to a computer and print them. Make sure that you have already configured the settings 
described in Wireless Network Settings for the Computer and Camera.

Actions Possible with the Camera Connected 
to a Computer
The following describes the actions possible when the camera is connected over a wireless 
network to a computer or when it is connected via an interface cable (wired network).

Camera Mode Action Wireless 
Connection

Wired 
Connection

Reference 
Page

Playback Mode

Download camera images to the 
computer using computer commands. p. 19

Download camera images to the 
computer using camera commands 
(direct transfer). 

p. 90

Send images to the computer and print 
them out on a connected printer using 
camera commands (printing via a 
computer).

p. 93

Shoot from the computer (remote 
shooting). p. 95

Upload images from the computer to the 
camera.

PDF 
manual

Add My Camera files to the camera. p. 42

Shooting Mode Save images automatically to the 
computer while shooting (auto transfer). p. 98
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Downloading/Printing Images Using Camera 
Commands (Direct Transfer)
This section explains the procedures for downloading images to the computer and printing 
them using the camera's direct transfer function. 

Downloading/Printing Images Using Camera Commands
This section shows how to use camera commands to download images to a computer and print 
them.

1 While connected, set the camera to the playback mode. 
For a wireless network connection, see Connecting (p. 85) and establish a connection 
between the camera and computer. 
To connect using the supplied interface cable (wired connection), attach the cable to the 
computer's USB port and the camera's DIGITAL terminal and prepare the camera for 
communication. 

The direct transfer icon will display at the top left 
of the camera's LCD monitor. During a wireless 
connection, an antenna will appear to the right of 
the direct transfer icon.

The Camera Control Window will open on the 
computer screen. 

All Images Transfers and saves all images to the computer.

New Images Transfers and saves to the computer only the images that have not been 
previously transferred.

Transfer Image Transfers and save the displayed image to the computer.

Wallpaper Transfers and saves single images to the computer as you view and select 
them. The transferred images display on the computer desktop.

Print Transfers the displayed image to the computer and prints it (wireless 
network connection only).

The printer settings must be configured before the Print option can be 
utilized. See Printer Settings for Printing via a Computer (p. 93).

See the Camera User Guide for instructions on wired connections 
between the camera and computer and for how to prepare the camera 
for communication.

Direct Transfer Icon
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All Images, New Images
2 Press the FFUNC./SET button.

The menu will appear at the bottom left of the 
LCD monitor.

3 Select [All Images] or [New Images] and press 
the  button.
Alternatively, after selecting [All Images] or 
[New Images],  select [Transfer] and press the 
FUNC./SET button.

The images will download. The wireless lamp and 
 button will blink while they are 

downloading. 
The screen in Step 1 will return when the 
download is complete. 
To halt downloading, press the FUNC./SET
button to cancel the download.

Direct Transfer Menu
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Transfer Image, Wallpaper, Print

2 Display the image on the LCD monitor. 
Only the image displayed here will be downloaded to the computer. 

3 Press the FFUNC./SET button.
The menu will appear at the bottom left of the 
LCD monitor.

4 Select [Transfer Image], [Wallpaper] or [Print] 
and press the  button.
Alternatively, after selecting [Transfer Image], 
[Wallpaper] or [Print], select [Transfer] and 
press the FFUNC./SET button.

The images will download. During downloading, 
the wireless lamp will blink. When downloading is 
complete, the screen will return to Step 1. 

If you selected [Wallpaper], the downloaded image will appear as the background image 
on the computer desktop. If you selected [Print], the downloaded image will print out.

Only JPEG images can be downloaded as wallpaper for a computer. On 
the Windows platform, the files are automatically created as BMP images.

Options selected by pressing the   button remain in effect even when 
the camera's power is switched off. The setting will be in effect the next 
time the  button is pressed. 

Direct Transfer Menu
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Printer Settings for Printing via a Computer
"Printing via a computer" involves using camera commands to automatically print images 
without modification as they are downloaded to the computer. When you initiate printing via a 
computer, the printer settings have to be configured in advance.

1 While connected, set the camera to the playback mode. 
For a wireless network connection, see Connecting (p. 85) and establish a connection 
between the camera and computer. 

To connect using the supplied interface cable (wired connection), attach the cable to the
computer's USB port and the camera's DIGITAL terminal and prepare the camera for
communication. 

2 When the Camera Control Window appears, 
click [Preferences].

3 Select [Change direct transfer download 
destination folder] and click [Next].
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4 Set the destination folder for downloaded 

images and the creation method for new 
folders for downloaded images and click 
[Next].
Before images are printed they get downloaded 
to the folder specified here.

5 Click [Settings].

6 Set the printer and paper size used when 
printing via a computer and click [OK]. 

7 Click [Finish].
This concludes the configuration.
The next time that you print via a computer, the 
image will print according to the settings 
configured in Step 6.
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Shooting from a Computer (Remote Shooting)
You can shoot still images by operating the camera shutter remotely from a computer over a 
wireless connection. This is particularly useful for checking images on the larger display of the 
computer as you record them and for high volume photography without worrying about filling 
the camera’s memory card.

Preparing for Remote Shooting
1 While connected, set the camera to the playback mode.

For a wireless network connection, see Connecting (p. 85).
The Camera Control Window will appear on the computer's screen.

2 Click the [Remote shooting] tab.

3 Click [Starts Remote Shooting].

4 Select a destination for the captured images and click [OK].

You cannot shoot remotely when the camera is connected via an interface 
cable (wired connection). 
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RemoteCapture Task Window 
The RemoteCapture Task window has the following features.

RemoteCapture Task locks the exposure and focus settings for the subject 
matter in the Viewfinder section. If the lighting or distance to the subject 
changes, click  to reset these settings.

Size and Resolution Selector
Selects the size and resolution at which images are captured.

You can add 
comments to images 
by placing a check 
mark here and 
typing text in the 
boxes below. 

Viewfinder Display
Click the [Start/Stop 
Viewfinder] button 
while a connection to 
the camera is open to 
display the image 
appearing in the 
camera’s viewfinder.

Slide this to zoom 
the camera in or out.

Set the basic camera settings here.

Rotation Settings
Sets the rotation 
parameters for 
images after they are 
captured.

Shows/Hides the 
viewfinder or detailed 
settings area.

Release Button
Releases the 
shutter.

Start/Stop Viewfinder 
Button
Starts or stops the 
viewfinder display.

Refresh Button
Resets the exposure, 
focus and white 
balance.
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Remote Shooting

1 Click  and check the subject in the viewfinder.
2 Change the image size or resolution, the rotation settings and the settings at the 

bottom of the window as required. 
If you intend to hold the camera vertically to photograph a subject, you can save the 
image to the computer with the correct orientation if you set the rotation settings in 
advance. 

3 Click the [Release] button.

Ensure that you turn off your computer’s standby mode before you begin 
remote shooting. The device performance cannot be guaranteed if the 
computer enters the standby mode.

If you set the [Auto Rotate] function to [On] while in shooting mode, the 
images will automatically rotate to the correct orientation in the Remote 
Shooting window.  

• You can release the shutter by pressing the camera’s shutter button or 
the keyboard’s space key.

• Other than the shutter button, the camera's buttons and switches, 
including the zoom, cannot be operated while the camera is being 
controlled with the Remote Shooting function. 

• You may notice that the interval between the shutter release and 
activation is slightly longer for remote shooting than when the camera 
is used independently. 
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Automatically Saving Images to the Computer 
while Shooting (Auto Transfer)
This section explains the function for automatically transferring images immediately after being 
shot to a computer connected wirelessly to the camera. 

1 While connected, set the camera to a shooting mode.
For a wireless network connection, see  Connecting (p. 85).
A window similar to the one at the right will 
appear on the computer's screen.

2 Press the camera's MMENU button.

3 In the [  (Wireless)] menu, select [Auto 
Transfer]. 

4 Select [On] and press the MMENU button. 
The Auto Transfer function will be in effect and 
the LCD monitor will change to the shooting 
screen.

Computer commands cannot be initiated while this function is in use.

•The image is transferred to the computer after it records onto the memory 
card in the camera. It is saved into the same folder as specified for 
downloads using the Direct Transfer function. 

•This function is not available for movies.
•See the Camera User Guide for instructions on operating your camera.

MENU
Button
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5 Shoot the image.

The image will be recorded onto the memory card and then sent to the computer. The 
transferred image will display on the computer.

A window similar to the one at the right will 
display while the image is transferring. 

You can still shoot images while this window 
displays.

Once you set the [Auto Transfer] to [On], it will be in effect the next time 
you shoot over a wireless connection and send the image to the 
computer after recording it onto the memory card in the camera.
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Wireless Connection Troubleshooting 

Please read this section if you cannot connect the camera and computer over a wireless 
network or you are having trouble using the wireless networking function. See Troubleshooting
(p. 114) for other types of problems. 

Connection Difficulty
Check the error message on the camera's LCD monitor if you are having difficulty getting the 
camera to establish a wireless connection with the computer, and try the following solutions.

"Connection failed 1" Message

Cause
Failed to obtain an IP address from the DHCP server.

Solution 1:
Check the DHCP server settings to confirm that they are correct, or confirm 
that there are a sufficient number of IP addresses that can be assigned. For 
details, see the user guide for the wireless LAN router. Consult with your 
network administrator if you have one.
Solution 2:
If your network is without a DHCP server, select the [Advanced Mode] and 
configure the IP address as described below.

How to Display the IP Address Configuration Screen
Perform steps 1-7 in Registering the Target Device with the Camera (p. 78) and 
continue with the procedures below.

Select [Advanced Mode] 
and click [Next]

Click [Set IP Address]
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"Connection failed 2" and "Connection failed 3" Message

Cause
Wireless network settings are incorrect. The registration of the target 
device on the camera may have failed.

Solution 1:
Attach the camera to the computer with the interface cable and check the 
following settings for the target device.
[Network Name (SSID)]
[Network Authorization - Encryption]

Solution 2
If you configured the connection in the [Simple Mode], select the [Advanced 
Mode] as described in Step 8 of Registering the Target Device with the 
Camera (p. 80) and reregister the computer with the camera. 

•An IP address is a unique identifying number assigned to a device, such 
as a camera or computer, connected to a network. 

•A DHCP (dynamic host configuration protocol) server is a server 
computer that issues IP addresses to cameras or computers on the 
network.

How to Check the Registration Information
Perform steps 1-7 in Registering the Target Device with the Camera (p. 78), continue 
with the procedures below and check the registration information.

Also use the above windows to confirm that the information recorded in the checklist 
(p. 77) is correct. 

Place a check mark in the box for [Change 
registered information in camera].

Check the 
camera's MAC 
address here.
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"Connection failed 4" Message

Cause 1
Connection broken because of poor wireless networking environment.

Solution 1:
Change the camera's orientation. 
Solution 2:
Bring the camera near the wireless LAN router or other access point device. 
Solution 3:
Change the channel of the wireless LAN router or other access point device. 

Cause 2
Cannot detect the access point for the target device.

Solution:
Confirm that the wireless LAN router or other access point device is operating 
correctly. For details, refer to the user guide for the wireless LAN router.

Cause 3
Failed authentication with the access point device.

Solution 1:
Attach the camera to the computer with the interface cable and check the 
following target device settings.
[Network Name (SSID)]
[Network Type]
[Network Authorization - Encryption]
[Encryption Key (Network Key)]
See How to Check the Registration Information (p. 101) for instructions.
Solution 2:
See How to Check the Registration Information and check the camera’s MAC address, 
then confirm that the access point is not configured for MAC address filtering.

Cause 4
Failed to detect target device within the time limit (30-second timeout).

Solution:
Check to confirm that the target device's (computer's) wireless networking 
function is operating correctly.

•A media access control (MAC) address is a hardware address that 
uniquely identifies each node of a network, such as a camera or 
computer, using a single worldwide number for the prefix.  

•MAC address filtering is a function that registers the MAC address of 
devices used on a wireless network with the wireless LAN router and 
denies access to unregistered MAC addresses.
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"Connection failed 5" Message

Cause 1
Connection confirmation signal processing failed.

Solution 1:
Enable the UPnPTM service in your firewall settings.
See Enabling the UPnPTM Service (p. 105) for details.
Solution 2:
Change the firewall settings to allow the program for wireless connections 
(CALWLESS.exe) to communicate with the camera through the firewall. See 
Enabling Communication for the Wireless Connection Program 
(CALWLESS.exe) (p. 105) for details.

Cause 2
Unable to connect within the time limit owing to a problem with the 
wireless network environment or the computer (30-second timeout).

Solution 1:
Change the camera's orientation. 
Solution 2:
Bring the camera near the wireless LAN router or other access point device. 
Solution 3:
Change the channel of the wireless LAN router or other access point device. 
Solution 4:
Confirm that the target device's (computer's) wireless networking function is 
operating correctly.  
Solution 5:
Enable the UPnPTM service in your firewall settings.
See Enabling the UPnPTM Service (p. 105) for details.

"Connection failed 6" Message

Cause
IP address duplicated.

Solution 1:
Power the camera off and on again and try to reconnect.
Solution 2:
If a fixed IP address has been assigned, change the assignment.
See How to Display the IP Addresses Configuration Screen (p. 100).



Using the Wireless Networking Function104

"Connection failed 7" Message

Cause
More than approximately 1000 images in the camera, you may not be able to 
download the camera images in this case.

Solution:
Use a memory card reader to download the images. (p. 22)

"Disconnected" Message

Cause
Could not detect the access point for the target device.
Or the wireless network environment was poor and the connection was 
broken.
Or connection confirmation signal processing failed.

Solution 1:
Change the camera's orientation. 
Solution 2:
Bring the camera near the wireless LAN router or other access point device. 
Solution 3:
Confirm that the wireless LAN router or other access point device is 
operating.
See the user guide for the wireless LAN router or other access point device. 
Solution 4:
Change the channel of the wireless LAN router or other access point device. 
Solution 5:
Confirm that the target device's (computer's) wireless networking function is 
operating correctly.  
Solution 6:
Enable the receipt of an ICMP echo request in your firewall settings.
See Enabling the Receipt of ICMP Echo Requests (p. 105) for details.
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Firewalls
Firewalls protect computers from security threats, such as computer viruses and unauthorized 
external access. However, some firewall settings may interfere with the connection between 
the camera and computer.

Windows XP Firewall 
If you are using the firewall provided with Windows XP Service Pack 2, the settings below are 
generally configured automatically at the time of installation. If you cannot establish a wireless 
connection between the camera and computer, click the [Start] menu, followed by [Control 
Panel] and then double-click [Windows Firewall].
Click the [Exceptions] or [Advanced] tab, and check the three settings listed below.

Other Security Software
If you are using a firewall provided by other security software, read the user guide for that 
program and check the three settings listed below.

Log onto your computer as the administrator before attempting to configure 
the firewall settings.

Enabling the Receipt of ICMP Echo Requests
The Internet Control Message Protocol (ICMP) is used to authenticate the connection 
between a camera and computer. Accordingly, ICMP must be enabled in your security 
software.

Enabling Communication for the Wireless Connection Program 
(CALWLESS.exe).
The firewall settings need to be changed to allow the program for wireless connections 
(CALWLESS.exe) to communicate with the camera through the firewall.
Usually, "CALWLESS.exe" is installed in the "C:\Program Files\Canon\CAL" folder, and its 
name may appear as [Canon Camera Access Library 8] in the firewall settings window.

Enabling the UPnPTM Service
The UPnPTM function is used when the program for the wireless connection attempts to 
detect the camera. Accordingly, the UPnPTM service must be enabled in your security 
software.
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Before Contacting Us
If you experience a problem, please follow the suggestions below. If these do not resolve your 
problem, please contact us.

Check Your Computer/Wireless LAN 
Router

Confirm that the computer and wireless LAN 
router are operating correctly and that the 
computer's wireless networking function is 
enabled. See the user guide for your computer 
or wireless LAN router for confirmation 
instructions. 

A connection between the camera and 
computer will not work if the computer 
and wireless LAN router do not 
communicate correctly.

Check Your Firewall Check your firewall settings. See Firewalls
(p. 105)Some firewall settings may prevent a 

connection between the camera and a 
computer. 

Check the Supplied Software Uninstall the software (p. 109) and reinstall it 
(p. 13).The camera and computer can be 

prevented from connecting if the 
supplied software is not correctly 
installed.

If none of the above solve your problem:

For Problems Other Than Wireless Networking
Troubleshooting (p. 114)

Refer to Our Website
Our support center offers answers to many inquiries.
http://canon.jp/support/

Customer Support Center
See the Canon Customer Support leaflet included with your camera.
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Appendices

This chapter introduces the CD-ROM supplied with your camera and the procedures for 
installing the programs. It also explains how to uninstall the programs.
Read the Troubleshooting section in this chapter if you experience a problem using the 
programs.

ArcSoft PhotoStudio 
ArcSoft PhotoStudio is a high-performance yet easy-to-use image editing program from 
ArcSoft, Inc. It can process, edit and print images. It includes color corrections, brightness 
adjustments and special effects. Install it from the supplied CD-ROM, the Canon Digital Camera 
Solution Disk, as required. 

Installing ArcSoft PhotoStudio 
Windows

1 Close all programs that are running.
2 Place the Canon Digital Camera Solution Disk in the CD-ROM drive.

If the installer panel displays, click [Exit] to close it.

3 Click the [Start] menu, and select [My Computer].
 Windows 2000, Windows Me and Windows 98 SE users, double-click the [My Computer] 
icon on the desktop.

4 Right-click the CD-ROM icon and select [Open].
5 Double-click the [ARCSOFT] folder or right-click it and select [Open], and double-

click the [SETUP.EXE] icon . 
Follow the onscreen messages to proceed with the installation.

Macintosh 

1 Close all programs that are running. 
2 Place the Canon Digital Camera Solution Disk in the CD-ROM drive.
3 Open the CD-ROM and double-click [ARCSOFT], followed by the [PhotoStudio 

Installer] icon . 
Follow the onscreen messages to proceed with the installation.

4 Click [OK] when a message appears stating that the installation is complete.
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Starting ArcSoft PhotoStudio 
You can start ArcSoft PhotoStudio from within ZoomBrowser EX (Windows) or ImageBrowser 
(Macintosh).

ZoomBrowser EX 
1 Click [Edit] in the Task Area of the Main Window, followed by [Edit Image]. 
2 Confirm that [1. Select Images] is selected and select an image to edit. 
3 Click [2. Select Editing Tool] and select [Edit with external image editor].
4 Select ArcSoft PhotoStudio from the program list and click [3. Finish].

ImageBrowser
1 Select an image to edit, click the [Edit] menu and select [ArcSoft PhotoStudio].

Manual for ArcSoft PhotoStudio 
You can obtain the ArcSoft PhotoStudio manual from the ArcSoft, Inc., website. Use your 
browser program to download the manual from the following URL:
http://www.arcsoft.com/support

If you cannot select ArcSoft PhotoStudio, register the program using the 
following procedures.

1. In Step 3 above, select [Edit with external image editor] and click 
[Manage List]. 

2.Click [Add] and select [ArcSoft PhotoStudio].
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Uninstalling the Software
The procedures for uninstalling the software are only required when you wish to delete the 
programs from your computer or when reinstallation is required to fix corrupted files.

Uninstalling the Software (Windows)

Software Installed from the Canon Digital Camera Solution Disk (excluding 
ArcSoft PhotoStudio)
This explanation uses ZoomBrowser EX to demonstrate how to uninstall a program.

1 Click the Windows [Start] menu and 
select [All Programs] or [Programs], 
followed by [Canon Utilities], 
[ZoomBrowser EX] and [ZoomBrowser 
EX Uninstall].

The uninstall utility will start and remove 
ZoomBrowser EX.

Uninstalling ArcSoft PhotoStudio
•Uninstall the program by clicking the [Start] menu and selecting [Control Panel] and [Add or 

Remove Programs].
•With Windows 2000/Me/98, uninstall the program by clicking the [Start] menu and selecting 

[Settings] followed by [Control Panel] and [Add/Remove Programs].

• You can remove other programs with the same procedures. 
•To uninstall CameraWindow, be sure to follow the following 

procedures.
1. Click the [Start] menu and select [All Programs] or [Programs], 

followed by [Canon Utilities], [CameraWindow], [PowerShot - IXY- 
IXUS - DVx] and [CameraWindow DC_DVx Uninstall].
The "x" stands for a number. If more than one exists, delete all copies 
of the program before proceeding to Step 2.

2. Click the [Start] menu and select [All Programs] or [Programs], 
followed by [Canon Utilities], [CameraWindow], [EOS Digital] and 
[CameraWindow Uninstall].

3. Click the [Start] menu and select [All Programs] or [Programs], 
followed by [Canon Utilities], [CameraWindow] and [CameraWindow 
Uninstall].

•PhotoRecord can be uninstalled by clicking the Windows [Start] menu 
and selecting [Programs] or [All Programs], followed by [Canon 
PhotoRecord] and [PhotoRecord Uninstall].
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Uninstalling the USB Driver (Windows)
Uninstall the USB Driver using the following procedures if you are using Windows 2000, 
Windows Me or Windows 98 SE. 

1 Attach the supplied interface cable to the computer’s USB port and the camera’s 
DIGITAL terminal. Prepare the camera for communication with the computer.
For interface cable connection instructions, see the Camera User Guide.

2 Click the [Finish] button if the Camera Control Window displays.

3 Click the [Start] menu and select 
[Settings], followed by [Control Panel].

4 Double-click the [Scanners and 
Cameras] icon or folder.

It is essential to note that you will not be able to download images if you 
uninstall the USB driver.

You do not need to uninstall the USB driver with Windows XP.
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5 Delete your camera model name or 

[Canon Camera] in the [Scanners and 
Cameras Properties] dialog.
Windows Me users should delete their 
camera model or [Canon Camera] in the 
[Scanners and Cameras] folder.

Windows 2000
Select your camera model name or [Canon Camera] and click [Remove].

Windows Me
Select your camera model name or [Canon Camera], right-click the mouse and select 
[Delete].

Windows 98 SE
Select your camera model name or [Canon Camera] and click [Remove]. Then turn off the 
camera and remove the interface cable from the computer's USB port.

6 Click the Windows [Start] menu and select [All Programs] or [Programs], followed 
by [Canon Utilities], [Camera TWAIN Driver x.x] and [Uninstall TWAIN Driver]. A 
version number appears in place of the “x.x”.
• Windows 2000, Windows 98 SE: Perform Step 6 with no substitutions.
• Windows Me: Substitute the following for the underlined portions of Step 6.

[Camera WIA Driver x.x], [Uninstall WIA Driver] 

The uninstall process will start.

To connect the camera to the computer and download after this point, use the following 
procedures.
1. Reinstall the driver.
2. Connect the camera to the computer with the interface cable. 

Uninstalling the Software (Macintosh)
Uninstall the programs by dragging the application’s folder (the folder in which it was installed) 
into the Trash, and then empty the Trash.

If your camera model name does not appear here, see the Camera not 
detected, Events dialog won’t display or images will not download to the 
computer (p. 115) of the Troubleshooting section.

Please be careful not to accidentally delete any folders with downloaded 
images that may be contained within the application folder. 
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Memory Card Folder Structure
The images on a memory card are placed in the [DCIM] folder in subfolders labeled 
[xxxCANON], where the “xxx” represents a number in the range 100 - 999. 

•*Files with the THM extension are the thumbnail image files for the camera’s index replay 
mode.

•The “xxxx” in file names represent four-digit numbers.
•**Each successive file shot in Stitch Assist mode is assigned a letter starting from “A,” which 

is inserted as the third digit in the name. i.e. [STA_0001.JPG], [STB_0002.JPG], 
[STC_0003.JPG]...

•All folders except the “xxxCANON” folders contain image settings files. Do not open or delete 
them. 

IMG_xxxx.JPG (JPEG images)
_MG_xxxx.JPG (JPEG images recorded in the 
Adobe RGB color space)
CRW_xxxx.CRW (RAW images)
_RW_xxxx.CRW (RAW images recorded in the 
Adobe RGB color space)
CRW_xxxx.THM*
STx_xxxx.JPG** (Stitch Assist mode images)
MVI_xxxx.AVI (Movies)
MVI_xxxx.THM*
SND_xxxx.WAV (Sound annotation)

The folder that holds the settings files for 
images in the DCIM folder.

The folder created when DPOF settings are set. 
It holds the DPOF settings files.

DCIM

MISC

xxxCANON

CANONMSC

SNDR xxxCANON

SDR_xxxx.WAV (Files recorded with Sound Recorder)
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Method for Downloading to a Computer 
without Additional Software

This explains the method for downloading images to a computer without installing 
ZoomBrowser EX/ImageBrowser. 

Windows XP (Installation of USB Driver Not Required) 
Your camera uses a standard image transfer protocol called Picture Transfer Protocol (PTP). 
With PTP and Windows XP, all you need do is connect the camera to the computer with an 
interface cable to easily download images using the Scanners and Cameras Wizard or other 
procedures. However, there are some inconveniences and limitations to this downloading 
method. See the For Windows® XP and Mac OS X Users leaflet for details. 

Windows Me (with the USB driver installed)
Easily download images using the Scanners and Cameras Wizard or Windows Explorer. All you 
need do is connect the camera to the computer with an interface cable.

See the Windows Help system for information about the Scanners and Cameras Wizard and 
Windows Explorer. 

To download images to a computer over a wireless connection, you must 
install the software included with your camera.



Appendices114

Troubleshooting
Please read this section if you encounter a problem using the software.
See Wireless Connection Troubleshooting (p. 100) for problems with wireless networking.

Start by Checking This
If you encounter problems, first check the following items.

Does your computer satisfy the requirements listed in the System 
Requirements section (p. 10)?

Is the camera correctly connected to the computer?

See the Camera User Guide for the correct connection procedures. Also 
check to ensure that you are using the correct cable and that it is securely 
attached at both ends. 

Is the camera set to the playback mode? (some models only)

Some models require the camera to be set to the playback mode to 
transfer data. See the Camera User Guide for details.

Is the battery sufficiently charged?

Check the battery charge if you are powering the camera with a battery. 
You are recommended to use a household power source (AC adapter) to 
power the camera when it is connected to a computer (if available for 
your camera model).

Problems
When a problem arises, check the causes and apply the solution(s). 

USB driver installation not proceeding well (Windows)

Uninstall the driver (p. 110) before reinstalling it with the procedures in Installing 
the Software and USB Driver (p. 13). 
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Add New Hardware Wizard or New Hardware Found (Windows 2000) 
Wizard displays when the camera is connected to the computer with an 
interface cable.

Click [Cancel] to close the window. Temporarily disconnect the camera from the 
computer. Next, read Start by Checking This on the previous page and resolve 
the problem.

Images won’t download into a TWAIN-compliant program (Camera and 
computer connected via interface cable (Windows 2000, Windows 98 SE)).

Click the [Finish] button in the Camera Control Window to close it.

Cannot download images or shoot remotely. (For cameras connected to 
the computer via an interface cable: only cameras supporting Hi-Speed 
USB 2.0).

The problem may be resolved by lowering the transmission speed for data by 
following the procedures below.

Solution:
Hold the MENU button on the camera down and press the (Print/Share) 
button and FUNC./SET button simultaneously. In the displayed screen, select 
[B] and press the FUNC./SET button.

Camera not detected, Events dialog won’t display or images will not 
download to the computer (when camera is connected to the computer 
via an interface cable).

Cause 1:
There is a problem with one of the items in the Start by Checking This
section (p. 114).

Solution:
Resolve the problem.

Cause 2:
The USB driver is not installed (Windows only).

Solution:
Install it with the procedures in Installing the Software and USB Driver (p. 13).

Cause 3:
The USB driver is not correctly installed (Windows only).

Solution:
Uninstall the driver (p. 110) before reinstalling it with the procedures in 
Installing the Software and USB Driver (p. 13).
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Cause 4:
The camera may have been recognized as another device under the 
following circumstances (Windows only).
• The camera was connected to the computer before the USB driver was 

installed.
• The [Scanners and Cameras] icon or the [Scanners and Cameras] folder cannot 

be found in the [Control Panel] or the [Printers and Other Hardware] window.
• Your camera model name, [Canon Camera] or a camera icon does not display 

in the [Scanners and Cameras Properties] dialog or the [Scanners and 
Cameras] folder.
Solution 1:
Start with the following procedures.
Install the USB driver with the procedures in Installing the Software and USB 
Driver (p. 13). Then connect the camera to the computer with the interface 
cable and prepare it to transfer data. If the USB driver is already installed, 
uninstall it first and then reinstall it.
Solution 2:
If the problem is not resolved with the procedures in Solution 1, continue by 
implementing the following procedures. The specific steps are explained 
below.
1.Check to see if the camera is being recognized as an “other” device.
2.Delete the driver and the setup information files if it is being recognized as 

an “other” device.
3.Reinstall the driver.

This section explains the specific steps for each operating system.

Windows XP and Windows 2000 

Check to see if the camera is being recognized as an “other” device and 
delete the driver if it is.

1. Windows XP: Click the [Start] menu, followed by [Control Panel], 
[Performance and Maintenance] and [System].
Windows 2000: Click the [Start] menu and select [Settings] and [Control 
Panel]. Double-click the [System] icon.

2. Click the [Hardware] tab, followed by [Device Manager].

Users of Windows XP and Windows 2000 must first log in as an 
Administrator (computer system administrator) to delete a driver.
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3. Click the  symbol beside the [Other devices] and/or [Imaging devices] 

category. Your camera model name or [Canon Camera] will display in these 
categories if it is being recognized as an “other” device.

4. Select your camera model name or [Canon Camera], right-click and select 
[Delete].

5. Click [OK] in the confirmation dialog.
Delete all instances of your camera model name or [Canon Camera] if it 
appears in one or more places in the [Other devices] or [Imaging devices] 
categories. 

6. Close the System Properties window.

Delete the setup information files

7. Double-click the [My Computer] icon on the desktop, followed by the [C:] 
drive, [WINNT] folder and [inf] folder.

There are other potential reasons for the problem if the “Other devices” 
or “Imaging devices” categories do not appear or your camera model 
name or [Canon Camera] does not appear. Proceed to Step 6, 
temporarily quit the procedures and investigate the other potential 
causes.

Step 7 and above are not required for Windows XP.
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8. Look for files for Canon digital cameras that start with [CAP*]. 
The “*” represents a number, such as 0 or 1. 
[CAP*] files come in pairs of [CAP*.inf] and [CAP*.pnf] files (For example, 
[CAP0.inf] and [CAP0.pnf]). 

9. Double-click the [CAP*] files to check their contents. 
Double-clicking a [CAP*.inf] file will open it in the Windows Notepad 
program. Look for [;****Canon Camera Driver Setup File****] in the first 
line. Note down the names of these files.

10.Delete the [CAP*] file set.
Delete the [CAP*.inf] and [CAP*.pnf] file for Canon digital cameras that you 
noted down in Step 9.

If the [inf] Folder Is Not Visible in the [WINNT] Folder
Use the following procedures to show all files and folders.

1. Open the [WINNT] folder.
2. Click the [Tools] menu and select [Folder Options].
3. Click the [View] tab.
4. In the [Files and Folders] category in the Advanced Settings section, set [Hidden files 

and folders] to [Show hidden files and folders]. Remove the check marks from [Hide 
file extensions for known file types] if it is present.

5. Click [OK] to close the dialog.

This will make the hidden files and folders visible.

Several sets of [CAP*] files may be present in the [inf] folder. Open up 
each file to confirm that it is an [CAP*] file for Canon digital cameras 
before you do anything with the file.

The [inf] folder contains numerous files critical to the computer’s 
operation. Be extremely careful to delete the correct files. If you delete 
the wrong files, you may be unable to restart Windows.
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Reinstall the driver.

11.Reinstall the driver with the procedures in Installing the Software and USB 
Driver (p. 13).

Windows Me/Windows 98 SE 
Check to see if the camera is being recognized as an “other” device and 
delete the driver if it is.

1. Click the [Start] menu and select [Settings], followed by [Control Panel]. 
Double-click the [System] icon.
This will display the System Properties window.

2. Click the [Device Manager] tab.
3. Click the  symbol beside the [Other devices] and/or [Imaging devices] 

category. Your camera model name or [Canon Camera] will display in these 
categories if it is being recognized as an “other” device.

4. Select your camera model name or [Canon Camera] and click [Remove].
5. Click [OK] in the confirmation dialog.

Delete all instances of your camera model name or [Canon Camera] if it 
appears in one or more places in the [Other devices] or [Imaging devices] 
categories. 

6. Click [OK] to close the System Properties window.

Delete the setup information files.

7. Double-click the [My Computer] icon on the desktop, followed by the [C:] 
drive, [WINDOWS] or [Windows] folder and [INF] or [Inf] folder.

There are other potential reasons for the problem if the “Other devices” 
or “Imaging devices” categories do not appear or your camera model 
name or [Canon Camera] does not appear. Proceed to Step 6, 
temporarily quit the procedures and investigate the other potential 
causes. 
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8. Find and delete the [DRVDATA.BIN] (or [Drvdata.bin]) and [DRVIDX.BIN] (or 
[Drvidx.bin]) files.

9. In the [INF] or [Inf] folder, double-click the [OTHER] or [Other] folder to open 
it.

10. Find and delete the [Canon.IncCAP xxx.Inf] file (The xxx 
represents numerals.).

If the [INF] Folder Is Not Visible in the [WINDOWS] Folder
Use the following procedures to show all files and folders.

1. Windows 98 SE: Click the [View] menu and select [Folder Options]. 
Windows Me: Click the [Tools] menu and select [Folder Options].

2. Click the [View] tab.
3. Windows 98 SE: Set the [Hide files] section to [Show all files].

Windows Me: Set the [Hidden files and folders] section to [Show hidden files and 
folders]. 

4. Click [OK] to close the dialog.

This will make the hidden files and folders visible.

You do not need to delete anything if none of the above files are 
contained in the [OTHER] folder.

The [INF] folder contains numerous files critical to the computer’s 
operation. Be extremely careful to delete the correct files. If you delete 
the wrong files, you may be unable to restart Windows.
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Reinstall the driver

11.Reinstall the driver with the procedures in Installing the Software and USB 
Driver (p. 13).

Zooming Images in ZoomBrowser EX is Slow or Not Working
Some graphics cards or settings may cause the display of zoomed images in ZoomBrowser EX 
to slow down or malfunction. If this occurs, set your computer display's Hardware acceleration 
setting to a lower setting. 

1. Click the Windows [Start] menu, followed by [Control Panel] and 
[Appearance and Themes].
With Windows 2000, Windows Me, or Windows 98 SE, click the [Start] menu 
and select [Settings], followed by [Control Panel]. 

2. Click the [Display] icon, followed by the [Settings] tab, [Advanced] button and 
[Troubleshoot] tab.
With Windows 2000, click the [Display] icon, followed by the [Settings] tab, 
[Advanced] button and [Troubleshoot] tab.
With Windows Me or Windows 98 SE, click the [Display] icon, followed by 
the [Settings] tab, [Advanced] button and [Performance] tab.

3. Set the [Hardware acceleration] to a setting below [Full] and click [OK].
4. Restart the computer if prompted.

If You Were Using ZoomBrowser EX Version 2 or 3
Take the following steps if you were using ZoomBrowser EX version 2 or 3 with Windows.

If Titles and Comments Were Attached to Your Images.
Take the following steps to display in version 5 the titles and comments you 
input in version 2/3.

1. Use Windows Explorer to open the [Program] folder within the folder in 
which you installed ZoomBrowser EX 5. 
(e.g. C:\Program Files\Canon\ZoomBrowser EX\Program)

2. Double-click [dbconverter.exe] found in this folder to start this utility.
3. Select the database file you were using up to this point and click the [Start] 

button. 
(e.g. C:\Program Files\Canon\ZoomBrowser EX\Database\My Database.zbd)

This will display the titles and comments input in the earlier versions in the 
comments section of ZoomBrowser EX 5.

If You Had Images in a Folder Below the Program Files Folder
Image files in the [Program Files] folder or a subfolder cannot be displayed in 
ZoomBrowser EX 5 from that location. To display these files, first perform steps 
1-3 above and then carry on with Step 4.
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4. Use Windows Explorer to copy the folder and the images it contains from the 

[Program Files] folder to another folder.
(e.g. Copy the image folders in C:\Program Files\Canon\ZoomBrowser 
EX\Library One to another location.)

The moved folder images can now be selected and displayed with 
ZoomBrowser EX 5.
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Information about Your Camera

The software package and the procedures for connecting to a computer and preparing for data 
transfers vary between camera models. Certain software functions may also not be supported 
by some camera models. 

Non-Supported Programs and Features
Applicable Camera Models

PowerShot SD430 DIGITAL ELPH WIRELESS/DIGITAL IXUS WIRELESS

Non-Supported Functions
• The camera does not record RAW images.
• The camera does not support the Display AF Frame function in the View 

Window.
• The camera does not support the Sound Recorder function.
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